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1 About this document

1.1 Document function
This manual is giving detailed information on the system capabilities and architecture. It 
supports project and sales engineers in designing the system architecture during acquisition 
and execution phase. Furthermore during operation time of the system all servicing 
personnel in need of detailed knowledge about the system capabilities.

1.1.1 Symbols

Safety symbols

Symbols for certain types of information and graphics

Symbols in graphics

Symbol Meaning

A0011189-EN

DANGER!
This symbol alerts you to a dangerous situation. Failure to avoid this situation will 
result in serious or fatal injury.

A0011190-EN

WARNING!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can 
result in serious or fatal injury.

A0011191-EN

CAUTION!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can 
result in minor or medium injury.

A0011192-EN

NOTICE!
This symbol contains information on procedures and other facts which do not result 
in personal injury.

Symbol Meaning

A0011193

Tip
Indicates additional information.

A0011195

Reference to page
Refers to the corresponding page number.

 ,  ,  ... Series of steps

A0018373

Result of a sequence of actions

Symbol Meaning

1, 2, 3 ... Item numbers

 ,  ,  ... Series of steps

A, B, C ... Views

A0011187

Hazardous area
Indicates a hazardous area.

A0011188

Indicates a non-hazardous location
Safe area (non-hazardous area)

DANGER

WARNING

CAUTION

NOTICE

1. 2.

1. 2.

-

.
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1.2 Documentation
For an overview of the scope of the associated Technical Documentation, refer to the 
following:
• W@M Device Viewer: Enter the serial number from the nameplate
www.endress.com/deviceviewer
• Endress+Hauser Operations App: Enter the serial number from the nameplate or 
scan the matrix code on the nameplate

1.3 Registered trademarks
Microsoft®, Windows® and Internet Explorer® 

Registered trademarks of the Microsoft Corporation

Modbus™
Modbus is a registered trademark of Schneider Electric USA, Inc.

Java®

Registered trademark of Sun Microsystems, Inc.

Mozilla® Firefox®

Registered trademark of the Mozilla Foundation

Enraf, Honeywell, Rosemount, Emerson, Saab, L&J, VAREC, GPE are registered trademarks 
and trademarks of these organizations and companies.
All other marks are property of their respective owners.
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2 Basic safety instructions

2.1 Requirements for the personnel
The personnel for installation, commissioning, diagnostics and maintenance must fulfil the 
following requirements: 

• Trained, qualified specialists: must have a relevant qualification for this specific function 
and task

• Are authorized by the plant owner or operator
• Are familiar with federal or national regulations
• Before beginning work, the specialist staff must have read and understood the instructions 

in the Operating Instructions and supplementary documentation as well as in the 
certificates (depending on the application)

• Following instructions and basic conditions

The operating personnel must fulfil the following requirements:

• Being instructed and authorized according to the requirements of the task by the facility's 
owner operator

• Following the instructions in these Operating Instructions

2.2 IT security
We only provide a warranty if the device is installed and used as described in the Operating 
Instructions. The device is equipped with security mechanisms to protect it against any 
inadvertent changes to the device settings.

IT security measures in line with operators' security standards and designed to provide 
additional protection for the device and device data transfer must be implemented by the 
operators themselves.

Endress+Hauser can provide support in performing this task.

2.3 Intended use

2.3.1 Applications

Inventory control

By using Tankvision Multi Scan to monitor the tank level and stored volume of valuable 
liquids remotely, owners or operators of tank farms or terminals for petroleum products and 
chemicals (liquids) can visualize the volume of the stored medium in real time. The data can 
be used to plan the inventory and distribution. The data can also be used to manage tank 
farm operations like pumping or transferring products. Tankvision has its unique concept 
using network technology. Without using proprietary software, the users can visualize and 
manage their valuable liquids stored in the tanks by a web browser. Tankvision Multi Scan 
is a flexible and cost effective solution due to its scalable architecture. The application 
coverage goes from small depots with only a few tanks up to refineries.

Inventory Calculations

Tankvision Multi Scan calculates based on measured variables and tank capacity tables:
• Observed or gross volumes
• Net volumes and
• Mass

of products like
• Hydrocarbons,
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• Liquefied gases,
• Asphalt.

They are corrected according to international standards, including API/ASTM tables 5A, 5B/
6, 53A, 53B/54, 23/24, LPG.
This includes temperature corrections at 15 °C, 60 °F and alternative temperatures. 
Additionally, available pump able volumes and water volume are calculated.

Remote configuration of measuring equipment

Some on-site operations can be avoided using remote configuration of measuring equipment 
during commissioning or maintenance (the availability of this feature may depend on the 
system configuration).

Application areas

• Tank farms in refineries
• Ship loading terminals
• Marketing and distribution terminals
• Pipeline terminals
• Logistic terminals for tanks storing products like crude oils, refined white and black 

products, chemicals, LPG

2.4 Workplace safety
For work on and with the device:

• Wear the required personal protective equipment according to federal or national 
regulations.

• Switch off the supply voltage before connecting the device.

2.5 Operational safety
Risk of injury!

• Operate the device in proper technical condition and fail-safe condition only.
• The operator is responsible for interference-free operation of the device.

Conversions to the device
Unnauthorized modifications to the device are not permitted and can lead to unforeseeable 
dangers.

• Consult with Endress+Hauser if modifications are required.

Repair
To ensure continued operational safety and reliability:

• Carry out repairs on the device only if they are expressly permitted.
• Observe federal and national regulations pertaining to repair of an electrical device.
• Use original spare parts and accessories from Endress+Hauser only.

2.6 Product safety
This measuring device is designed in accordance with good engineering practice to meet 
state-of-the-art safety requirements, has been tested, and left the factory in a condition in 
which it is safe to operate. It meets general safety standards and legal requirements. 
It also complies with the EC directives listed in the device-specific EC Declaration of 
Conformity. Endress+Hauser confirms this by affixing the CE mark to the device.
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3 Overview

3.1 Tankvision Multi Scan NXA83B
The Multi Scan NXA83B is a small integrated tank gauging and tank inventory management 
system utilizing the latest embedded Windows technology.
In addition to being a small tank inventory management system it can also be used as a 
foreign device gateway to higher level DCS and site wide business information systems by 
providing an open interface to older legacy and proprietary protocols and interfaces.

It features:
• Windows 10 IoT operating system
• An optional full graphical LCD display with touchscreen technology
• Up to 8 communication ports configurable as host or field interfaces
• Inventory Calculations
• A wide range of communications protocols
• Fanless and diskless operation
• A maximum of 256 tanks
• OPC Data Access Server
• System health monitoring via watchdog

A0047372

1 SAAB TRL2
2 Ethernet (OPC)
3 ENRAF BPM
4 DCS (MODBUS)
5 MODBUS Tank Gauges
6 ENRAF CIU 858
7 WHESSOE 550
8 VAREC MARK/SPACE
9 ETHERNET
10 USB

POWER

FUSE   HBC T3A15  250V

NETWORK

1

USB 1 USB 2
COM 2COM 1 COM 3 COM 4

COM 7COM 6COM 5 COM 8 COM 10COM 9 COM 11 COM 12

COM 15COM 14COM 13 COM 16 COM 19COM 18COM 17 COM 20

NETWORK

2

AUDIO

VGA

Rx

Tx

1 2 3 4

5 6 7 8

Rx

Tx

9 10 11 12

13 14 15 16 17 18 19 20

Rx

Tx

1 2 3 4 5 6 7 8

9 10
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3.2 Configurator
The Multi Scan NXA83B is configured using the Tankvision Multi Scan Configurator 
software.
The software is pre-installed on the D drive of the NXA83B and may be accessed using 
remote control from a networked PC.

The Multi Scan NXA83B actually has two copies of its database:
• The Runtime database stored in the ProgramData folder on the D drive. This is the 

database that is actually used as the current "live" database and is never directly edited by 
the user.

• The Configurator copy of the database stored in the Configurator folder on the D drive. 
This is the one that is edited by the user when using the Configurator software.

The procedure to edit the Multi Scan NXA83B database is to use the Configurator software 
in the Multi Scan NXA83B to edit the configurator database. Then when the changes are 
complete the new database must be set as the Runtime database using the Set As Runtime 
Database menu option. The database will be automatically copied to the ProgramData 
folder and the DCC services restarted.

From version 3.1.0 / 4.0.0 onwards there is no need to carry out a commit or reboot 
the Multi Scan NXA83B. The new database will immediately become active after the 
DCC services have restarted. 
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4 Quick Start

4.1 Configuring using onboard Configurator tools
This section gives a quick overview for connecting to the current version of the Multi Scan 
NXA83B.

To start the Tankvision Multi Scan Configurator tools:

Connect a cross-over network cable between the PC and the Multi Scan NXA83B.

Configure the network settings on the PC to use a fixed IP address of 10.54.113.252.

In case a different IP address was assigned to the Multi Scan the IP address of the PC 
must be in the same range.

Ensure the Multi Scan NXA83B is running.

Start a Remote Desktop Connection on the PC and connect to the NXA83B. → ä 17

Close the NXA83B tankgauging screen, to get access to the operating system. → ä 11

Start the Tankvision Multi Scan Configurator software from the shortcut on the 
Windows Desktop.

Select the Communications → Port Configuration menu item:

–Configure all Host ports used to interrogate field devices for tank data.
–Configure all Slave ports used to send Live and Calculated tank data to other computer 
systems, such as a DCS or SCADA.

Select the Communication → Gauge Configuration menu item and configure all field 
devices, such as Level gauges, Generic IO etc.

If volume data is to be calculated for tanks then carry out the following:

–Select the Configuration → Strap Tables menu item to enter any strapping  tables.
–Select the Configuration → Tank Characteristics menu item to configure the volume 
calculations for the tanks

If software alarms are to be generated in the Multi Scan NXA83B then use the menu 
option Configuration → Alarm Configuration to configure these.

Use the menu item Communication → Manual Data to set up the source of data 
parameters as Live or Manual.

Carry out any other configuration tasks.

Select the File → Set As Runtime Database menu item to save the database and set it 
to be the runtime database. The Communications sub-system will be automatically 
restarted and become operational.

4.

5.

6.

7.

8.

9.

10.

11.

12.

13.
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5 Configuration, Connecting, Network Settings
Multi Scan NXA83B configuration consists of the following sets of tasks:
• Configuring the operating system functions such as Networking, Printers etc.
• Configuring the database
• Configuring the Features to be used, such as Alarm Annunciation, TouchScreen display 

etc.

The first set of tasks can be carried out either directly on the Multi Scan NXA83B using a 
keyboard/mouse or via a remote networked PC. These tasks will be described in this section.
The second set of tasks (configuring the database) can only be carried out via a remote 
networked PC, using the Tankvision Multi Scan Configurator set of tools already loaded onto 
the NXA83B. This constitutes the bulk of the configuration work for the Multi Scan NXA83B 
and is covered in a separate Configuration manual. An introduction to the Configurator tools 
will be given in this section.

It is no longer necessary to carry out a commit when modifying the tankgauging 
database. However, when certain system features are modified then they will not be 
permanent until saved with the Unified Write Filter temporarily disabled. These will be 
defined later in this document. 

5.1 Accessing the operating system
The Windows operating system is normally hidden behind the main Multi Scan NXA83B 
operator screens, and cannot be accessed. However, in order to carry out most configuration 
tasks, access is required to the operating system. In this case the operator display must be 
stopped.

To do this first requires keyboard/mouse input, which can be carried out in one of two ways:
• Connect a keyboard and mouse to the USB ports of Multi Scan NXA83B and use the LCD 

display. This is only recommended for changing system settings such as Network Name / 
Address. It should not be used to configure the operational database.

• Connect a PC to the Multi Scan NXA83B using the Ethernet port and take control of the 
Multi Scan NXA83B using the Remote Desktop Connection feature of Windows.

For details on the latter method → ä 17.
To stop the operator display screens, open the right (Screens) menu, select the down arrow 
to show the next bank of options and click on the Exit option.
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NXA83_Grid-View_EXIT

The login screen will be displayed.
Enter the Administrator password to continue. This will be set to MConfig1221 when the 
Multi Scan NXA83B is shipped, but may be changed using the Tankvision Multi Scan 
Configurator tools.

If a valid password is entered the operator screens will close and the Windows Desktop will 
be shown.

NXA83_Windows-Desktop_Low-Resolution

NOTICE
Any changes of the windows settings could affect the correct operation of the Multi 
Scan NXA83B. Therefore:
‣ Take extreme care when modifying any of the windows settings.
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Any changes that are carried out in the operating system will not be permanent until 
committed in the Unified Write Filter.

5.1.1 Exiting from the Remote Control session
If no changes have been made to the configuration and the remote desktop session is no 
longer required, then the NXA83B can be returned to the standard Operator Touchscreen 
using the Return To Main Screen shortcut.

NXA83_Windows-Desktop_Return-to-Main-Screen_Icons

This will automatically set the screen resolution to 640*480 and start the operator display. 
Then close the RealVNC remote control software.

If any changes have been made to the operating system settings then a Commit should 
be carried out instead of this option. If the tankgauging database only has been 
modified then a commit is not required.

5.2 Network Settings
The Tankvision Multi Scan has two Ethernet ports, referred to in the Windows operating 
system as Local Area Connection and Local Area Connection 2.

NXA83_Windows-Desktop_Network_conn.png

For the physical locations of the network connections, refer to the Installation manual
(BA01290G).

The Multi Scan NXA83B is shipped with the following default network settings:
• Computer Name: MINI
• Local Area Connection: Fixed TCP/IP Address: 10.54.113.250
• Local Area Connection 2: Fixed TCP/IP Address: 10.54.113.251
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For most applications these will be perfectly adequate and should be left as standard. 
However they may be changed at configuration time to fit in with an existing network on 
site.
To change the settings follow the procedure described in this manual (→ ä 14).
The TCP/IP addresses can be changed using the Local Area Connection properties in the 
Control Panel. This includes using DHCP to dynamically assign an address on an established 
network.

Any changes to the network settings will be permanent and do not require saving via 
the Unified Write Filter. (→ ä 15).

5.3 Renaming the MINI network name
The network name of the Multi Scan NXA83B is set by default to MINI, and in most cases it 
is recommended that it be left as this.

However, if the name needs to be changed then this can be performed using the following 
procedure:

Disable the UWF and reboot the system. See later section on this.

Use the Control Panel → System screen to change the name, just as for a standard PC 
running Windows.

After the name has been changed, do NOT reboot the Multi Scan NXA83B when asked.

Use the REBOOT shortcut to re-enable the UWF and make the changes permanent.

NOTICE
Modifying the "MINI" name will have repercussions in the Tankvision Multi Scan 
Configurator tool as it uses that name to communicate with the Multi Scan NXA83B. 
Therefore:
‣ After changing the MINI name, edit the project settings according to the figure shown.

NXA83_Windows-Desktop_Edit_Project_Settings.png

Any changes will not be permanent until the REBOOT is used to re-enable the Unified 
Write Filter → ä 15.

5.4 Printer Settings
In order for the print features in the Multi Scan NXA83B to work, a printer needs to be 
configured in the Windows operating system as the DEFAULT printer.

If a printer was ordered with the Tankvision Multi Scan then the printer drivers will be 
configured on the device and no other configuration is required.

4.
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A printer can be installed after the Multi Scan NXA83B has been shipped, in the same way 
as installing on a normal PC running Windows. However, due to the restrictions on the flash 
disk space, it is recommended that only the basic printer driver should be loaded and not any 
print utilities. After installing a new printer, remember to delete ALL other printers from the 
system.
For the above reasons it is recommended that Endress+Hauser should be consulted on the 
type of printer to be attached to the Multi Scan NXA83B.
The printer should normally be connected to the Multi Scan NXA83B via one of the USB 
ports. However network printers can also be supported.
The UWF should be disabled before installing any printer software, and the changes made 
permanent by using REBOOT shortcut to re-enable the UWF.

Any printer setting changes will not be permanent until a REBOOT is carried out and 
the Unified Write Filter is re-enabled.

Only ONE printer is supported, therefore delete ALL other printers installed on the 
system.

5.5 Connecting a modem
The communications layer of the Multi Scan NXA83B, DCC, can handle modem 
communications on both master and slave interfaces.
At the moment an external modem should be used, connected to one of the serial ports. 
However it should also be possible to connect via the USB ports.
The modem driver should be installed on the operating system as for a normal PC running 
Windows.
It is recommended that Endress+Hauser should be consulted before selecting the modem, or 
Endress+Hauser can supply a suitable modem.
The UWF should be disabled before installing any modem, and the changes made 
permanent by using REBOOT shortcut to re-enable the UWF.

Any modem setting changes will not be permanent until a REBOOT is carried out and 
the Unified Write Filter is re-enabled.

5.6 Unified Write Filter (UWF)
The Multi Scan NXA83B runs under the Windows 1 IOT operating system, which includes a 
component called the Unified Write Filter (UWF).
This is used to protect the C drive and prevents files from being corrupted by a sudden loss 
of power; therefore it is perfectly safe to switch off the Multi Scan NXA83B without shutting 
down the operating system. It is a replacement for the Enhanced Write Filter used in 
previous versions of Windows and acts in a similar way, but does have some major 
differences.

It works by caching all disk and operating system changes in memory rather than writing to 
the disk. Thus if the Tankvision Multi Scan loses power it will never corrupt the protected 
disk, however all system changes will be lost.
If the Tankvision Multi Scan operating system needs to be re-configured then the UWF must 
be temporarily disabled before carrying out the changes. These will then be made permanent 
by using the REBOOT shortcut to re-enable the UWF. 

The procedure to carry out any system changes is:

From the main windows menu select the UWF → REBOOT Disable Write Filter item.
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NXA83_Windows-Desktop_Reboot_Disable_Write_Filter

A DOS shell will be displayed, press any key to continue.

NXA83_Windows-Desktop_Reboot_Disable_F_DOS

The system will shutdown and restart with the UWF disabled.

Carry out any system changes such as renaming the Network name, add a printer etc.

Use the REBOOT shortcut item on the main windows background to re-enable the UWF 
and make the changes permanent.

NXA83_Windows-Desktop_Enabling_UWF

A DOS shell will be displayed, press any key to continue and reboot with the UWF 
enabled.

4.

5.



Tankvision Multi Scan NXA83B Configuration, Connecting, Network Settings

Endress+Hauser 17

The Tankvision Multi Scan should only be set with the UWF disabled when re-configuring 
the operating system or any other operations that affect the C drive. It does not need to be 
disabled when configuring the runtime database. It should never be left for any length of 
time with the UWF disabled as any loss of power in this state could corrupt the operating 
system. The operator screen will indicate in the information bar if the UWF is currently 
disabled:

NXA83_Windows-Desktop_UWF_Status_indication

NOTICE
Risk of damage to the operating system due to disabled Unified Write Filter.
‣ Never leave the Unified Write Filter disabled for any length of time.
‣ Ensure the Unified Write Filter is enabled at the end of any configuration session.

The C drive is part of the EWF protection therefore any data written to that drive (including 
any changes to the Windows operating system) requires the UWF to be disabled before 
carrying then out.

The D drive is not part of the UWF protection, therefore any data written to that drive is 
immediately permanent and does NOT require any actions with the UWF. The Tankvision 
Multi Scan tankgauging database is stored on the D drive and does not require any UWF 
actions to make changes permanent.

NOTICE
Risk of operating system corruption.
‣ Never switch off the power when the Unified Write Filter is disabled!

If the Tankvision Multi Scan is left in the state of the UWF disabled, after one hour it 
will automatically carry out a REBOOT and enable the UWF.

5.7 Remote Control via a networked PC
In many circumstances it is not feasible to connect a Keyboard and Mouse directly to the 
Multi Scan NXA83B, but access to the operating system is required. In this case a networked 
PC can be used to take control of the Multi Scan NXA83B using the Windows feature called 
Remote Desktop Connection.
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The Multi Scan NXA83B and remote PC must be networked together, either as part of a 
larger network, or directly using a cross-over network cable.

To connect using a direct connection:

Set the networking on the remote PC to a Fixed IP address with a value similar to the 
Multi Scan NXA83B. For instance if the Multi Scan NXA83B address is 10.54.113.250 
(the default address for Network 1), then set the PC address to 10.54.113.251

Connect a network cable between the Multi Scan NXA83B and the PC. For more details, 
refer to the Installation manual (BA01290G).

On a PC running Windows select: Start → All Programs → Accessories → 
Communications → Remote Desktop Connection.
Or, on a PC running Windows 7 run: C:\Windows\System32\mstsc.exe.

NXA83_Remote-Desktop-Connection

Enter the computer name (or IP adress) of the Multi Scan NXA83B then click on 
Connect. Unless it has been changed, the computer name will be MINI. 

Enter the account details for administrator access on the Multi Scan NXA83B. Unless 
this has been changed the account details will be:

• User name: administrator
• Password: MConfig1221

Then click OK.

The display on the Multi Scan NXA83B will now be shown on the remote PC. See previous 
section on how to stop the operator display to gain access to the operating system → ä 11.

When the remote session is established the screen on the Multi Scan NXA83B will no longer 
be active and will display the standard Windows login message. Therefore only use the 
Remote System Login when it is safe to. I.e. when no operator needs to view data on the 
Multi Scan NXA83B.

5.8 Configuring the Features used on the Multi Scan 
NXA83B

The Multi Scan NXA83B can be setup to suit a number of applications where certain features 
may not be required. For instance on large refineries the Alarm Annunciation pop-up screen 
may not be required, or simple data gatherer systems may not require volume calculations.

The Features that may be configured include the following:
• No Annunciation of Events – the event viewer will not be started, however events will 

still be logged to the standard event log files so they can be viewed historically.
• No Operator Touchscreen display – the operator screens will not be started. The option 

may be of use if the Multi Scan NXA83B has no touch screen installed.

4.

5.

6.
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• No Programmable Alarms – the programmable alarm configuration screens will not be 
available in the Configurator.

• No Volume Calculations – the screens associated with volume calculations will not be 
available in the Configurator. These include the Tank Characteristics, Tank Capacity 
Tables and Product Configuration screens.

To  configure the Features, click on the Windows start menu item Start → All Programs → 
Commit → Set Features and Commit.

NXA83_Configuration_025

This screen will ask a series of Yes or No questions to enable or disable features. After all 
have been answered by a Y or N, it will then carry out a Commit and reboot sequence to make 
the changes permanent.

NXA83_Configuration_026
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5.9 Configuring the Multi Scan NXA83B database
The Multi Scan Configurator software is used to configure the database for the Multi Scan 
NXA83B.
The Configurator software may also be installed on a separate PC if required, although it is 
recommended that the onboard tools are used.

The Multi Scan NXA83B actually has two copies of its database:
• The Runtime database stored in the ProgramData folder on the D drive. This is the 

database that is actually used as the current "live" database and is never directly edited by 
the user.

• The Configurator copy of the database stored in the Configurator folder on the D drive. 
This is the one that is edited by the user when using the Configurator software.

The procedure to edit the Multi Scan NXA83B database is to use the Configurator software 
in the Multi Scan NXA83B to edit the configurator database, then when the changes are 
complete the new database must be set as the Runtime database using the Set As Runtime 
Database menu option. The database will be automatically copied to the ProgramData 
folder and the DCC services restarted.

From version 3.1.0/4.0.0 onwards there is no need to carry out a commit or reboot the 
Multi Scan NXA83B. The new database will immediately become active after the DCC 
services have restarted.

To run the Configurator software on the NXA83B, a suitable PC should be connected to the 
Multi Scan NXA83B via a standard Ethernet network. This could be as part of a larger 
network or using a direct cross-over network cable between the PC and the Multi Scan 
NXA83B.
Before running the software, the user should log onto the NXA83B using the Windows 
Remote Desktop Connection and shut down the tankgauging display, so that access to the 
operating system is available. Refer to previous sections of this manual for details on how to 
do this.
To start the Configurator tools, double click on the Embedded Config icon on the desktop as 
shown in the following figure.

NXA83_Windows-Desktop_Embedded_Icon

The Configurator software allows the Multi Scan NXA83B to be configured for a wide range 
of functions, including:
• Host and Slave Communication ports
• Tank Inventory Data
• Programmable alarms
• Products
• Manual data
• Strapping data

The standard tank gauging displays for the Multi Scan NXA83B may also be configured to 
display only the data required.
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When configuration is complete the database may be set as the Runtime by clicking on the 
menu option Set As Runtime Database. The database will be automatically copied to the 
ProgramData folder and the DCC services restarted. There is no need to carry out a commit.
For full details on how to configure the database → ä 32.

5.10 OPC access accounts 
The Multi Scan NXA83B is configured with a standard Windows user account that may be 
used by any OPC clients to access the OPC Server. This has the following details:
• Username: OPCUser
• Password: OPCPassword

If a different account is required, to match an existing account in the client system, then it 
must be created in the Multi Scan NXA83B using the command line utility with the following 
lines:
net user OPCUser OPCPassword /add /EXPIRES:NEVER
net localgroup Administrators OPCUser /add
net user OPCUser /EXPIRES:NEVER

Replace OPCUser and OPCPassword with the new account user name and password.
Make sure a commit is carried out after the account has been added.
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6 Maintenance - Data Communications 
Controller

6.1 Stopping and Starting DCC
The DCC runs as a set of services which are automatically started when the Multi Scan 
NXA83B is started. There may, however, be times when it is necessary to stop or restart the 
services.

To Stop the DCC services, start the DCC Config utility by selecting the windows menu item
Start → All Programs → DCC Services → Stop

NXA83_Windows-Desktop_DCCConfig_Start-menu

A screen will displayed showing the process of stopping all the DCC services.

NXA83_Windows-Desktop_DCCConfig_Stop
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When all services are stopped it will disappear automatically.

There is no need to disable the watchdog before stopping the services, this will be 
disabled as part of the stop process.

To start the DCC Host again simply click the menu option Start→ All Programs → DCC 
Services → Start.
The same screen will show the process of starting all services and will disappear when all 
processes have been started.
The watchdog will be re-enabled as part of the start services process.

6.2 Communications Monitor
The Communications Monitor is a set of diagnostic screens that allow the status of the field 
ports to be viewed and controlled. It also allows the redundancy status to be viewed and 
controlled when the Multi Scan NXA83B is part of a redundant pair of systems.

To view the DCC Host Communications Monitor, double click the DCC Monitor shortcut icon 
on the Windows Desktop:

NXA83_Windows-Desktop_DCC_Monitor

This will bring up the following screen:

NXA83_Configuration_027

The Comms Monitor module allows the user to view the data communication that occurs 
between the Multi Scan NXA83B and any connected devices such as tank gauges. 

To view communications, select the desired Host COM port from the drop down list. e.g. 
Com 1. A list of gauges being polled on the selected COM port will be displayed in the box 
below.
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One item always available in the COM Port drop down list is SIMULATOR, this is a software 
feature which simulates gauges within DCC Host and is treated exactly the same as a normal 
COM port.

A blue arrow scrolls through the device list to indicate the gauge currently being polled. A 
red arrow will be displayed against a device being polled on fast scan.

NXA83_Configuration_028

From this page the Configuration, Statistics, Product Information, Status and Incoming 
Raw Data may be viewed.

Refer to the DCC Configuration manual BA01292G for more information.

6.3 Multi Scan NXA83B Watchdog
The Multi Scan NXA83B has a system watchdog component that monitors the health of the 
DCCHost communication service. If no communications occur (i.e. gauge data is not updated) 
for one minute, then the Multi Scan NXA83B will automatically reboot.
The watchdog will always be set to enabled when a Multi Scan NXA83B is dispatched from 
Endress+Hauser. It should always be enabled during normal operation.
There should be no need to manually disable the watchdog, as this will be done 
automatically when required, for instance when the DCCServices are stopped or a Firmware 
update is carried out.

6.4 Diagnostic Logging
The Multi Scan NXA83B maintains a set of log files to record such items as alarm/events, 
system startup, system changes etc. These are logged in the "Historical" directory on the D 
drive. This directory is also shared on the network and can be accessed remotely for 
diagnostic purposes.
All files in the Historical directory are text files and can be read using the standard Notepad 
program. The File ActionsRecord.log records actions which can change the functioning of 
the Tankvision Multi Scan and other items such as boot times, watchdog trips etc.
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NXA83_Configuration_029

The directory Events is used to store the historical event log files, with a separate file being 
created per day.

NXA83_Configuration_031

6.5 SNMP Server
An SNMP server is available on the Multi Scan NXA83B, allowing SNMP clients to connect 
via the ethernet port and view diagnostic data on the system health, redundancy status and 
communication port status. They can also control some features, such initiating redundant 
switchovers.
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7 NXA83B Configuration

7.1 System Configuration
The Multi Scan NXA83B is configured using the Tankvision Multi Scan Configurator 
software which is installed onboard the NXA83B as standard. A PC is then required to 
connect to the NXA83B using Remote Desktop Connection, to run the Configurator 
software.
The Configurator PC should be connected to the Multi Scan NXA83B via a standard Ethernet 
network. This could be as part of a larger network or using a direct cross-over network cable 
between the PC and the Multi Scan NXA83B.
The user can store different versions of the database, which may be reloaded for later use.

The Configurator software allows the Multi Scan NXA83B to be configured for a wide range 
of functions, including:
• Host and Slave Communication ports
• Field devices
• Tank Inventory Data
• Programmable alarms
• Products
• Manual data
• Strapping data
• Display screens 

The standard tank gauging display for the Multi Scan NXA83B may also be configured to 
display only the data required.
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7.2 Configurator
The Multi Scan NXA83B is configured using the Tankvision Multi Scan Configurator 
software. This is started by double clicking on the Tankvision Multi Scan Configurator 
icon.
The Configurator will automatically start the SQL Server database.

NXA83_Configurator

All configuration actions are accessed from this software.

7.2.1 Projects
The Configurator may be used to configure many Multi Scan NXA83B devices, by saving 
each NXA83B to a new project within the configurator.
Only one project may be opened at a time, and each project has the database for one Multi 
Scan NXA83B.
The current open project is shown in the top right of the Configurator screen.

NXA83_Configurator_Configuration_Current-Project

1 Configurator Screen: Current open project

When started, the Configurator will open the last previously opened project.
If the project loaded in the Configurator is not the current runtime project then a pop-up 
message will be displayed to indicate this.

1
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NXA83_Configurator_Configuration_Current-Project_Pop-Up

The top line of the Configurator will also show the name of the actual project used as the 
runtime.

NXA83_Configurator_Configuration_Current-Project_Top-Line

All actions carried out in the Configurator will be saved in the current project database unless 
the Save As option is selected in the File menu.

To change the current project, click on the File → Projects menu.

NXA83_Configurator_Projects

When carrying out project actions, if the current project has been edited, a message will be 
displayed with a prompt to save the existing data.

NXA83_Configurator_Project_Save-Changes

Click Yes to save the existing project, after which the new project actions will take place.
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7.2.2 New Project
To create a new blank project select New Project from the File → Projects menu. The SQL 
Server database will be automatically restarted before the new project selection screen is 
shown.

NXA83_Configurator_Create-New-Project

Enter the new project name then click OK to create the new project and set it as the currently 
open project in the Configurator.

After the database has been configured it should be set as the current runtime by clicking on 
the menu option File→ Set As Runtime Database.

Before creating a new project always save any changes to the current open project, as 
they will be discarded when the new project is created.

7.2.3 Open Project
To open an existing project select Open Project from the File → Projects menu.
Select from the list of projects, and then click on OK.

NXA83_Configurator_Open-Project

The project details and database will be loaded into the Configurator as the current open 
project.
To set the project as the current runtime, click on the menu option File→ Set As Runtime 
Database.

Before opening a project always save any changes to the current open project, as they 
will be discarded when the selected project is opened.
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7.2.4 Saving Projects
To save the current open project, select Save Project from the File → Projects menu.
To save the project and all its data to a new project, select Save As from the File → Projects 
menu:

NXA83_Configurator_Save-Project

Enter the new name for the project then click OK.
The current open project will be changed to the new project.
An existing project may be specified, in which case that project will be overwritten.
Saved projects files will be written to a directory with the name of the project. This directory 
will be located at:
D:\Program Files\Tankvision Multiscan Configurator\Projects

The database will be automatically saved when the Set As Runtime Database menu 
option is used, therefore there should generally be little need to use the Save menu 
option.

7.2.5 Backing up and restoring projects
To make a backup of a project to a USB memory stick, carry out the following:

Save the project via the Tankvision Multi Scan Configurator.

Plug a memory stick into a free USB port.

Copy the saved directory (→ ä 30) to the USB memory stick.

Remove the USB memory stick.

To restore a backup project or load a project from another Multi Scan NXA83B, carry out the 
following:

Plug the memory stick containing the backup project into a free USB port.

Copy the backup project directory from the USB memory stick to the location: 
D:\Program Files\Tankvision Multiscan Configurator\Projects

Start the Tankvision Multi Scan Configurator and open the project (→ ä 29).

Use the File → Set As Runtime Database menu option.

4.

4.
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7.2.6 Setting the project as Runtime
After making any changes to the configurator project it needs to be set as the current 
runtime database, to do this click on the File → Set As Runtime Database menu option.
The database will first be saved and then copied to the runtime database location, after 
which the DCC services will be automatically restarted. A command line window will be 
displayed showing the state of the re-start.

NXA83_Configurator_Set-as-Runtime-Database

When this window disappears the action is complete and the project is set as the current 
runtime. The communication sub-system is now using the new project.

There is no need to restart the Multi Scan NXA83B or carry out a COMMIT. 
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8 Database Configuration

8.1 Port Configuration
The Multi Scan NXA83B has a component installed called the Data Communications 
Controller (DCC) which consists of a number of services responsible for transmitting tank 
data to and from the device.

The three main services are:
• DCC Host - responsible for retrieving data from gauges and storing it in the database
• DCC Slave - responsible for sending tank data to other computer systems
• OPC Server - responsible for providing tank data to OPC clients

The Host and Slave services control communications over a number serial ports on the Multi 
Scan NXA83B and these must be configured with a software protocol before they can be 
used.
The OPC Server service communicates via the network and requires no configuration.
This section of the manual provides an overview of how to configure the NXA83B 
communications sub-system. For a more detailed description refer to the separate DCC 
Configuration manual (BA01292G).

8.1.1 Data Communications Controller
The ports used in the DCC component of the Multi Scan NXA83B are configured by selecting 
the Port Configuration option from the Communications menu of the Tankvision Multi 
Scan Configurator.
This consists of a number of tabbed pages to configure the Host and Slave ports.

NXA83_Data-Communications-Controller

The License tab allows the licensing details to be viewed for the current open project. These 
are automatically retrieved from the Multi Scan NXA83B when the database is imported.
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NXA83_Data-Communications-Controller_License



Database Configuration Tankvision Multi Scan NXA83B

34 Endress+Hauser

8.1.2 Configuring a Host or Slave port
Host ports are responsible for collecting data from Datacons and gauges, and command 
requests from any PC Tankgauging clients.
Slave ports are responsible for sending data to other computer systems, such as the main 
Distributed Control System (DCS) for the refinery, using protocol such as Modbus.

To configure a port click on the Host Comms or Slave Comms tab in the Data 
Communications Controller tool.

NXA83_Data-Communications-Controller_Host-Comms

For more information on configuring the communication ports, refer to the separate DCC 
Configuration manual (BA01292G).



Tankvision Multi Scan NXA83B Database Configuration

Endress+Hauser 35

8.2 Configuring protocols
Most of the Slave protocols (Modbus, Enraf etc.) and some Host protocols (Modbus TG) 
require extra configuration that is specific to the protocol.
To configure any protocol specific data, select either the Advanced Gauge Configuration or 
the Slave Interface Configuration item from the Communications menu

NXA83_DCC-Host-Configuration_User-Defined-Alarm

Advanced Gauge Configuration Screen

NXA83_DCCSlave-Configuration

Refer to the separate DCC configuration manual for details on configuring the protocol data.
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8.3 Gauge Configuration
The Multi Scan NXA83B must be configured for all gauges which will be used in the 
database.
This consists of defining data for each gauge, such as name, type, COM port etc., and is 
carried out using the Gauge Configuration tool.

To launch the Gauge Configuration tool, select Gauge Configuration from the 
Communications menu. The Gauge Configuration will hold any gauges/field devices that 
are already configured, for review or editing of their settings. Alternatively, the form will be 
empty if no gauges/field devices have been configured yet.
Each manufacturers gauge has different basic requirements for configuration. A knowledge 
of the different makes and models of gauges is useful at this stage although not essential, 
provided that the characteristics of the actual gauges present in the system are known. The 
following instructions do not provide an exhaustive guide as to the valid options and 
selections for each type of gauge; rather instruction is given as to the way in which the 
information is entered into the system.
A set of Application notes are available which give more detailed information on how to 
configure the different gauge types. In addition to this manufacturer’s literature should be 
consulted for further information.

NXA83_Configuration_001

The form displays the configuration of one device (such as a gauge) at a time. The buttons 
on the lower left of the form navigate through the list of gauges. The < and > buttons move 
one gauge back or forward respectively. The |<< button moves to the first gauge and the 
>>| button moves to the last. The Device Number drop-down list provides an alternative 
means of navigating directly to a particular gauge. The Device Numbers are allocated 
automatically by the system as new gauges are added, generally in order of creation, and 
cannot be edited by the user.

To add a new device to the list, click on the Add button. A new blank entry will be displayed 
and the editing features will be enabled. Alternatively, a new gauge may be added to the list 
by copying an existing one. In this case, click on the Copy button and then select the gauge 
from which the copy should be made. This will produce a new entry and the editing features 
will be enabled, but the displayed settings will replicate those of the gauge from which the 
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copy was made. The effect of adding a gauge to the configuration will usually be to add a 
corresponding tank to the Multi Scan NXA83B display, unless the gauge is part of a multi-
gauge setup.

To delete an existing device, click on the Delete button. Doing so will remove the 
corresponding tank from the Multi Scan NXA83B display unless the device is part of a multi-
gauge setup.

To edit the configuration of an existing device, navigate through the list to the desired device 
and then click on the Edit button.

The buttons at the right side of the form will be enabled (black text) or disabled (greyed out) 
depending upon the context of what stage in the configuration the user is at. For example, 
the Save button will be enabled whenever any setting for the currently displayed device is 
changed, prompting the user to apply any changes before moving on to another device. A 
message box will be displayed as a further reminder to apply changes.

Closing the tool by means of the Exit or × button or selecting a different device without 
saving first will discard any changes made. To discard any erroneous changes made whilst 
editing the configuration of a device, click on the Cancel button.

When configuring a new device, it is recommended to progress through the selections and 
options in column order, starting by working down the left column. Certain selections, e.g. 
Device Type, will affect the appearance and data entry requirements of other settings and 
options further down the column and may "clear" any current settings in preparation for the 
user's new entries.

Once all settings for the gauge have been configured, apply the settings by clicking on the 
Save button
Once all configurations have been completed, click on Exit to leave the Gauge Configuration 
tool.

8.3.1 Normal / Advanced view mode
The fields displayed will be determined by the Device Type selected and also by the view 
mode selected, Normal or Advanced 
The default view mode is Normal and it is recommended that this is the mode that should 
be used, as it simplifies the screen and displays only the data normally required for the device 
being configured. 
If it is required to view the full set of fields, then to switch from the Normal view mode click 
on the Advanced button in the bottom right hand corner. 
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NXA83_Configuration_002

The full set of fields are displayed.
Click on the Normal button to revert back.

8.3.2 Common fields 
The following fields will be displayed for most device types.

The Device Type drop-down list provides a selection of gauges and field devices of various 
models from various manufacturers. Select the one that matches or most closely resembles 
the actual gauge or device which will be connected. Note that the selection affects the way 
in which the communications of the Multi Scan NXA83B behaves.

The Tank Id entry links the gauge to a tank in the Multi Scan NXA83B system. Typically, 
each gauge will be associated with a unique tank, though in the case of multi-gauge setups 
there will be a number of gauges all fitted to the same tank and thus share a common Tank 
ID.

Comm Port is the number of the port on the Multi Scan NXA83B to which the the gauge 
itself is connected. There are two fields for the Comm Port. The left hand field is the main 
COM port used for communications, and should always have a value entered. In Advanced 
mode a right hand field will also be displayed but is only required for redundant systems, and 
specifies the Backup Comm Port.

If the gauge is one of a number of gauges all fitted to the same tank, select Multi-Gauges. 
An additional frame will be displayed wherein the Gauge Duty should be selected. There 
should be only one Primary Gauge on each tank, the others should be Secondary Gauges or 
used for other specific duties as listed in the drop down menu (→ ä 40).

Certain gauges which are provided with multi-element averaging or multi-spot temperature 
measurement may allow the individual element temperatures to be read via the 
communications. If this feature is available and desired, select Poll For Temp. Elements.
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The average product temperature will normally be polled for regardless of this setting, 
therefore only tick this box if the individual elements are required to be available in the 
Multi Scan NXA83B.

Certain gauges which are provided with skin temperature measurement may allow the 
individual temperatures to be read via the communications, up to a maximum of 
250 elements. This feature is normally only available on LNG tanks and is used in 
combination with an auxiliary gauge. If it is available and desired, select Skin Temp. Fitted.

8.3.3 Gauge specific fields 
The fields displayed in the area outlined below will vary depending on the device type 
selected.

NXA83_Device-Configuration_Gauge-Specific-Fields

Gauge specific fields

The fields in this area generally refer to device/gauge addresses, Modbus registers, 
communication tasks etc., and are very specific to the Device being configured and the 
protocol being used to communicate.
Refer to the separate Application notes for full descriptions of what fields are available for a 
device type and how to configure them.

8.3.4 Background Scan fields 
Product Level is the primary data item and is the default item polled from the gauge by the 
system. Background scan settings are used to read Auxiliary data parameters other than 
Product Level from the gauge at lesser frequency than the Level polls. 
The fields displayed in the Background Scan section are dependant on the Device Type 
selected and generally are used to enable polling for parameters such as Temperatures, 
Pressures, Density, Water Level etc.
Refer to the separate Application notes for full descriptions of what fields are available for a 
device type and how to configure them.
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8.3.5 Advanced fields
The following fields are normally only displayed if the Advanced view is selected.

TankMaster Index /Datacon Gauge Index 
This field is not normally required for a Multi Scan NXA83B and should normally be left as 
zero. However there are a number of circumstances where it may be required, as outlined 
below.
If a TankMaster slave interface has been configured the TankMaster Index will be the index 
used to reply to requests from a Tankmaster system. Each Device should have a separate 
unique index, from 0 to 255.
If a Datacon master interface has been configured, and the Comm Port for this device has 
been assigned to that interface then the Datacon Gauge Index is the address, or "position" 
within the internal configuration database, of the Datacon where this gauge will reside. The 
positions are addressed from 0 to 255. Each gauge must have a unique Tank Address, which 
for convenience should normally be set the same as the Gauge Number.

This field is NOT required if only Datacon slave interfaces have been configured on the 
Multi Scan NXA83B.

Flow Rate Damping and Flow Rate Integration
To alter the response of the level flow rate measurement by the system, and consequently 
the volume and mass/weight flow rates, two parameters are available for user configuration.
The Flow Rate Damping factor is a percentage measure of how much of the current 
instantaneous flow rate reading is incorporated into the filtered value. Increasing the figure 
increases the responsiveness of the resulting flow rates but reduces the effective damping.
The Flow Rate Integration factor is a time in seconds, up to 240 seconds maximum (four 
minutes), used to increase the effect of damping where the level readings/flow rate 
calculations are performed at shorter intervals depending upon the number of gauges 
present on the particular communications port.

8.3.6 Change Dimensions
The Multi Scan NXA83B will assume that any values read from the gauges/field devices are 
in Metric units unless the system is able to determine the measurement units of the gauge/
field device automatically via the communications. If this is the case, the Change Dimensions 
entries should be left in their default setting of AUTO. With certain gauges, the system must 
be configured specifically to match the measurement units of the data from the gauge by 
selecting the appropriate units of measure from the drop-down lists.

8.3.7 Multi Gauges
Tanks may be fitted with more than one gauge, for enhanced reliability. For example most 
LNG tanks will typically have two level gauges, one alarm gauge and one densitometer 
device fitted. To configure multiple gauges for a tank, perform the following in the Gauge 
Configuration screen:

Enter the same Tank Id for each gauge.

Tick the Multi Gauges box, this will display the Gauge Duty panel.

Select the appropriate duty from the Gauge Duty panel.
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NXA83_Device-Configuration_Multi-Gauges-Steps

1 Drop Down Menu: Tank ID
2 Tickbox: Multi Gauges
3 Drop Down Menu: Gauge Duty

Most configuration data entered for the multi-gauge tanks will be saved for all the gauges 
on that tank. This applies to data entered in the Tank Characteristics and the Alarm 
Configuration screens. Consequently, when a programmable alarm is triggered on a multi-
gauge tank, an alarm event will be generated for each gauge on the tank. 

Data entered in the Manual Data screen only applies to an individual gauge. 

The Gauge Duty defines how the gauge will be treated in the various operator displays. Most 
of the default screens supplied with the NXA83B are configured to display the primary gauge 
data. However they may be configured to show data from any other duty.

The available gauge duties are listed below.

Primary
One gauge must be configured as the primary duty gauge. This is the normal gauge used to 
display tank data in the operator screens.
If a Densitometer duty gauge is also present on a tank then the Product Density and 
Observed Temperature will be automatically be copied from the Densitometer to the 
primary.
Only one Primary gauge may be configured per tank.

Secondary
If a second level gauge is required on a tank, e.g. for redundancy purposes, set the duty of 
this gauge to Secondary. The secondary gauge may be added to the displays as required and 
may be accessed via Modbus and OPC interfaces. If the Difference Alarm is enabled for a 
tank, it monitors the Primary and Secondary gauge levels and generates an alarm if they 
differ by more than the preset tolerance.
Only one Secondary gauge should be configured per tank.

Backup
Any furher level gauges on a tank should be configured as Backup duty. These may be added 
to the displays as required and may be accessed via Modbus and OPC interfaces. The alarm 
gauge in an LNG tank should be configured as Backup duty.

1

2

3
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Densitometer
This duty is only required for LNG tanks. Densitometer is used for devices such as the 
Scientific Instruments 6280/6290, although any gauge capable of carrying out profiles may 
be configured as a densitometer. The main purpose of Densitometer gauges is to carry out 
profiles and calculate the product density, which is then automatically transferred to the 
primary gauge for volume calculations.

Auxiliary
An auxiliary gauge is different from all other gauge duties. It is not treated as a separate 
gauge, instead it is used to retrieve background scan parameters (pressures, temperatures, 
water bottom etc.) from a separate device and store them in the Primary gauge. 

An auxiliary gauge will not poll for level, generate alarms or be displayed in the operator 
screens. It is typically used on a Modbus TG interface to access parameters from devices such 
as pressure transducers. All data retrieved from an auxiliary gauge will be transferred to the 
Primary gauge and used in the volume calculations. 

Parameters that may be polled on an auxiliary gauge include:
• Product Temperature
• Vapour Temperature
• Density
• All Pressures
• Multi-Element temperatures (not transferred to Primary)
• Skin Temperatures (not transferred to Primary)
• Water bottom

8.4 Tank Characteristics
Tank Characteristics allows entry of or editing of the main tank operating parameters.

A number of the data items are important to the tank inventory calculations and it is 
therefore essential that they are configured correctly.

The tank characteristics module is a multi-tabbed data entry form where data has been 
organized into logical groups.

Tank characteristics are divided into several sections:
• Tank Details
• Tank Capacity Tables
• Roof Details
• Shell Correction
• Miscellaneous
• VCF Settings
• Calculation Control Settings
• Input Control Settings

Some values are dependent on other settings. Indeed some fields are not visible or enabled 
until they are called for by the setting of another parameter.
The use of this feature can be controlled by the security system.

Some settings are specific to certain calculation methods.

Tank Details screen
JIS Calculation Method requires a JIS Volume Correction Method AND a floating roof tank.
Correction Volume and Calibration density require a JIS volume correction method.

VCF settings screen
Enraf polynomial constants A and B require EnrafChem2 Poly or EnrafChem1 Poly volume 
correction method. C, D and E are only in EnrafChem1 Poly.
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The label "Chemical Concentration" changes to "Alcohol strength by volume" or "Alcohol 
strength by mass" depending on the type of chemical calculation selected.

• HMD, Nitric = Chemical Concentration
• OIML_R22_STRXVOL, JIS_K2250_STRXVOL = Alcohol strength by volume
• OIML_R22_STRXMASS = Alcohol strength by mass

8.4.1 Launching Tank Characteristics
Select the Tank Characteristics option from the Configuration menu. 

The following display is typical of what will be loaded. 

NXA83_Tank-Characteristics

The list box will contain the list of all tanks.
Expand the tanks tree view in the list and click on the required item.

OK, Apply, and Cancel buttons are provided.

Use the Forward and Back  buttons to move through the history of edited pages.
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8.4.2 Modifying Data Within Tank Characteristics
Select the tank to be modified from the list. The current details for the tank will be displayed. 

If this is the first time Tank Characteristics has been loaded after installing the system, 
it will be displaying default values. It is essential that default values are replaced with 
the correct operating values. 

Select the field to be edited and enter/select the new data.

Each field is validated both during data entry and just before the data is saved to the 
database. 
You can use the TAB key to move to the next data entry field. 

Press the Apply button to save the changes to the database.

If you want to abandon the changes press the Cancel button. 

If you attempt to select another tank after making some changes but before they are saved 
to the database, the system will warn you that changes have been made and request 
confirmation of whether they need to be saved or cancelled. 
Follow the same procedure to edit further tanks.
 
To exit the module, either close the Window or press the Cancel button.
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8.4.3 Data Item Definitions
The following sections provide definitions of each of the data fields within each section of 
the Tank Characteristics module.

Tank Details

NXA83_Tank-Characteristics_Tank-Details

Tank Shape – the physical shape of the tank. Four principle tank shapes are supported:
• VC: Vertical Cylinder
• VCFR: Vertrical Cylinder with Floating Roof
• SP: Sphere
• HZ: Horizontal Cylinder

There are other similar tank shapes. However, most should fall into one of the above types. 
Vertical Cylinders that have internal floating blankets/decks should be configured as VCFR. 

Product – Select the required product for the tank from the drop down list.

Volume Correction Method – the table is related to the product that will be stored in the 
tank. It defines the method and operating ranges for certain characteristics of the product.
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NXA83_Tank-Characteristics_Volume-Correction-Method

It is essential that the volume correction method is selected correctly as this affects the 
inventory calculation algorithms. 

Vapour Calculation – Specifies the vapour correction calculations that will be performed as 
part of the inventory calculations. None means that no vapour correction will be performed.
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NXA83_Tank-Characteristics_Vapour-Calculation

Min Operating Level – the defined minimum operating level of the tank. The accuracy of 
this value is important as it is also used to determine the minimum operating volume and 
consequently the amount of Usable Volume in the Tank.

Max Operating Level – the defined maximum operating level of the tank. The accuracy of 
this value is important as it is also used to determine the maximum operating volume and 
consequently the amount of Ullage Volume (Available Room) in the Tank.

Min & Max Operating Volume – Are read-only fields provided for your reference.

Reference Height is no longer on this screen. It is set (along with Shell Capacity) in 
the Tank Capacity Table screen.

JIS Calculation Method – Specifies the handling of floating roof corrections within JIS 
calculations.
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NXA83_Tank-Characteristics_JIS-Calculation-Method

Method of Calculation – By selecting a suitable calculation method, the user can cause the 
Calculation Control settings and Input Control Settings to be preset to values which are the 
accepted (or defined) default for the relevant standards body or type. These settings are then 
locked. If the user wishes to change these locked values, the Method of Calculation must be 
reset to ‘None’. The table below shows which settings are affected.
Certain calculation types rely on this setting. 
For example, Hydrostatic Deformation will only be included if the Method of Calculation has 
been set to GBT or GBT(Direct_Weight).

* In the case of JIS_MDP calculations setting the control flag "VCF is restricted" forces the 
rounding of input data to use +/- 0.002 kg/l and +/-0.25 °C.

Industry standard Flag

IP Roof weight specified in Air
Enable tank shell correction
Use IP calculation of TOV/GOV
Include suspended sediment & water
Do Not Combine sediment and water
VCF is normal
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API Roof weight specified in Air
Enable tank shell correction
WCF uses Table 56 calculation
Use API calculation of TOV/GOV
Include suspended sediment and water
Combine sediment and water
Net values calculated from gross
VCF is normal

GB/T Roof weight specified in Air
Enable tank shell correction
WCF uses fixed 0.0011 kg/l
Use API calculation of TOV/GOV
Include suspended sediment and water
Combine sediment and water 
Net values calculated from gross
VCF is normal

GB/T (Direct Weight) Roof weight specified in Air
Enable tank shell correction
WCF uses fixed 0.0011 kg/l
Use API calculation of TOV/GOV
Include suspended sediment and water
Combine sediment and water 
Net values calculated from gross
WCF uses short Table 56
VCF is normal

GOST Roof weight specified in in Vacuum (mass)
Use IP calculation of TOV/GOV
Net values calculated from gross
WCF uses short Table 56

JIS Gauge reads reference density
Roof weight specified in in Vacuum (mass)
WCF uses Table 56 calculation
Use API calculation of TOV/GOV
Disregard suspended sediment and water
Do Not Combine sediment and water
Water density 1.000 kg/l for fresh water
Net values calculated from gross
Tank shell is not insulated
VCF is normal

JIS-MDP Gauge reads reference density
Roof weight specified in in Vacuum (mass)
WCF uses Table 56 calculation
Use API calculation of TOV/GOV
Disregard suspended sediment and water
Do Not Combine sediment and water
Water density 1.000 kg/l for fresh water
Net values calculated from gross
Tank shell is not insulated
VCF is restricted

Industry standard Flag
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Tank Capacity Tables

In this section the chosen Tank Capacity Table is bound to the selected tank.

NXA83_Configuration_005

In this case tank TANK01 is bound to tank capacity table TANK1 which has been previously 
defined in the Tank Capacity Table option and has been saved to the Tank Capacity Table 
database.
It is not necessary to use the same name for the Tank and the Table but this nomenclature 
has been used for the default tables for historical reasons.

Density Tables

Density Tables are not supported in the Multi Scan NXA83B.
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Roof Details

The Roof Details section contains data that is relevant to floating roof tanks, i.e. those that 
have been defined with a tank shape of VCFR.

NXA83_Tank-Characteristics_Roof-Details

Leg Position
Some floating roofs have legs which may be set at two positions, thus altering the level at 
which the roof floats or is supported on the legs. Since the legs are usually attached to the 
floating roof, the Up position of the legs allows the roof to descend to a lower level in the 
tank, and is the setting used in normal operation, whereas the Down position causes the roof 
to become supported on its legs at a higher level and is the setting used for maintenance 
purposes. 

Where a tank has a floating roof with fixed or one - position legs, it is advisable to set the 
"Legs Up" and "Legs Down" levels to be the same so that the Legs "Up/Down" selection becomes 
irrelevant.

Fully Floating Level, Legs Up – The point at which the roof just ceases to be resting on its 
legs when the legs are in the "up" or operational position, such that the whole weight of the 
roof is being supported by its buoyancy in the product. Above this level, compensation is 
made for the displacement of the product by the full weight of the roof. 

Fully Floating Level, Legs Down – The point at which the roof just ceases to be resting on 
its legs when the legs are in the "down" or maintenance position, such that the whole weight 
of the roof is being supported by its buoyancy in the product. Above this level, compensation 
is made for the displacement of the product by the full weight of the roof. 
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Fully Supported Level, Legs Up – The point at which the roof legs are supporting the full 
weight of the roof when the legs are in the "up" or operational position. Below this level, no 
compensation is made for product displacement caused by roof weight.

Fully Supported Level, Legs Down – The point at which the roof legs are supporting the full 
weight of the roof when the legs are in the "down" or maintenance position. Below this level, 
no compensation is made for product displacement caused by roof weight. 

The area between the Fully Supported and Fully Floating levels is generally referred to as the 
roof transition zone. Between these levels it is difficult to determine the proportion of the 
roof's weight which is being held by the legs and therefore difficult to calculate the 
displacement of product by the roof. For this reason this region of the tank is normally 
avoided during normal operation.

Tank Corrections

NXA83_Tank-Characteristics_Shell-Correction

The tank correction information is only relevant if you have enabled shell correction on the 
Inventory Control Settings tab.

Shell Insulation Factor – 1 for completely insulated storage, 0 for un-insulated storage, 
0.875 is a typical value.

Shell Expansion Coefficient – Expansion coefficient of the material your tank is constructed 
of, e.g. 0.0000112 for mild steel.
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Shell Reference Temperature – Normally the same reference temperature used for your 
VCF calculations (normally either 15 °C or 30 °C).

Manual Air Temperature – The manual air temperature setting, if your gauge can provide 
an automatic air temperature, then leave it unchecked.

Gauge Temperature Coefficient – The linear coefficient of thermal expansion for the gauge 
and it's mountings. The typical values are the same as those for Shell Expansion Coefficient.

Gauge Reference Temperature – The temperature at which the gauge was calibrated.

Float Diameter – Diameter of the gauge float.

Float Weight – Weight of the gauge float.

Float Reference Density – The density of the fluid in which the float was calibrated.

Miscellaneous

This section contains various housekeeping features that do not affect the behaviour of the 
system, but are provided for operators to note additional information about the tank.

NXA83_Tank-Characteristics_Miscellaneous
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VCF Settings

NXA83_Tank-Characteristics_VCF-Settings

This section contains various settings applicable to Volume Correction Factor calculations. In 
previous versions, some of these settings were available in Manual Data.

The Enraf polynomial constants are only made available when an Enraf volume 
correction method is selected.

Inventory Settings

The settings on these pages control the way the inventory calculations are performed. The 
default settings are modified by clicking on the arrow and selecting the new setting from 
dialog. 
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Calculation control settings

NXA83_Tank-Characteristics_Inventory-Settings

Setting 1 (unset) Setting 2 (Set) Explanation

Disable tank shell correction Enable tank shell correction When checked the tank shell correction 
calculation will be performed, enter shell 
correction information on the relevant tab in 
this module.

Do not apply hydrometer 
correction in VCF

 Apply hydrometer correction 
to VCF

Set according to whether hydrometer correction 
is required or not.

WCF uses Table 56 correction WCF uses fixed 0.0011 kg/l Select this to use a calculated WCF, which gives 
better accuracy when calculating WCF.

Use IP calculation of TOV/
GOV

Use API calculation of TOV/
GOV

Set if you wish to use American (US) style 
calculations, which perform the floating roof 
and free water corrections at a different stage to 
the British calculations.

Disregard suspended 
sediment and water

Include suspended sediment 
& water

Set if you want include sediment and water 
correction in your inventory calculations.

Combined sediment and 
water calculation

Separate sediment & water 
calculation

Set if you want sediment and water correction 
calculated separately.

Water density 1.0 kg/l for 
fresh water

Water density 1.020 kg/l for 
sea water

Set according to whether the water you have in 
your tanks is fresh or sea water.

Tank calculated as 
hydrocarbon storage

Tank calculated for ballast/
slops storage

When set movements in and out of the tank are 
assumed to leave a constant oil depth and vary 
the amount of water in the tank.
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Dip thermal correction is 
disregarded

Dip thermal correction is 
enabled

Set if correction for temperature is applied to 
dip.

Gauge dip type is Ullage Gauge dip type is Innage If Dip thermal correction is enabled, selects 
which type of gauge to apply correction to.

Disable correction for 
Buoyancy gauges

Enable correction for 
Buoyancy gauges

When set, correction is applied for buoyancy 
type gauges.

Net values calculated from 
gross

Net values calculated from 
NOV-NSV chain

If set, net values are calculated from gross, 
otherwise from prior calculated NOV and NSV 
values. Only applicable to IP calculation 
methods.

Mass calculated from 
standard conditions

Mass calculated from 
observed conditions

–

Range checking is enabled Range checking is disabled If set, checks to ensure input values are within 
acceptable range are turned off.

Compressibility factor is 
disregarded

Compressibility factor is 
applied

If set, the compressibility factor will be applied to 
calculations.

Tank shell is not insulated Tank shell is insulated If set, tank shell insulation will be included in 
calculations.

WCF uses main Table 56 WCF uses short Table 56 Weight correction factor calculations use "Table 
56". This exists in a "short" or "main" version. If 
set, the short version will be used.

VCF is normal VCF is restricted When set, VCF output is restricted to 4 decimal 
places.

Use equilibrium pressure as 
per D1250/04

Use equilibrium pressure as 
per D1250/04 addendum 1

When set, the 2007 addendum to MPMS 11.1 
D1250/04 regarding equilibrium pressure is 
applied.

Setting 1 (unset) Setting 2 (Set) Explanation
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Input Control Settings

NXA83_Configuration_006

Setting 1 (unset) Setting 2 (Set) Description

Gauge levels are innage Gauge levels are ullage The levels returned by the gauge are innage 
(referenced from the bottom) or ullage 
(referenced from the top).

Ullage level zero = Max. 
Operating Level

Ullage level zero = Reference 
Height

Zero ullage is taken as the highest safe working 
level or the maximum height of the tank.

Gauge reads reference density Gauge reads observed density Use this setting with care! When set the 
inventory calculator derives the reference 
density from the observed density information, 
if you enter manual densities be aware of 
whether you enter a reference density or an 
observed density.

Gauge reads density in 
vacuum

Gauge reads density in air When set an allowance for the density of air will 
be made during inventory calculations.

Gauge reads relative pressure Gauge reads absolute 
pressure

Internally pressures are stored in Bar absolute, 
checking this option will cause the pressure 
stored to be calculated from the gauged value.

Tonnes/hour flow rate 
specified in air

Tonnes/hour flow rate 
specified in vacuum

Check this if you want a mass flow rate as 
opposed to a weight flow rate.

Roof weight specified in air Roof weight specified in 
vacuum

If you know the mass of your floating roof, set to 
Roof Weight Specified in vacuum.

Display Innage Level Display Ullage Level Causes levels displayed to be switch between 
innage and ullage.
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8.5 Tank Capacity Data Configuration

8.5.1 Introduction
Tank capacity tables are required if the system is to calculate inventory data.

Each capacity table needs to be provided in a comma separated variable text file.

The accuracy of the volumes calculated by the system is only as good as the accuracy of 
the tank capacity points provided.

The utmost care must be taken when selecting the capacity points to be used. Indeed where 
possible the original tank strap points should be entered to get the best accuracy.

The use of this feature can be controlled by the security system.

Use product temperature in 
vapour calculations

Use vapour temperature in 
vapour calculations

Sets which temperature is used by vapour 
calculations.

Average gauge temperature is 
product temperature

Average gauge temperature is 
vapour temperature

–

Free water volume is normal Free water volume is manual 
overide

If set, free water volume is determined from free 
water level, otherwise it is manually inputted.

Liquid pressure is from P1 Liquid pressure is from P2 Determines where liquid pressure is read from.

Debug output is enabled Debug output is disabled When set, debug logging is enabled. 
<Not available to users, internal flag only>

Setting 1 (unset) Setting 2 (Set) Description
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8.5.2 Loading the Tank Capacity Table Module
Select Configuration → Strap Tables from the main menu. 
The Tank Capacity Table module will be loaded as follows.

NXA83_Configuration_007

The list of tables will be populated with all tank capacity tables currently configured.

Tank capacity tables are bound to tanks in the tank characteristics menu option.

8.5.3 Adding a New Tank Capacity Table
Select File → New from the menu bar.
Put the name in Table ID

NXA83_Configuration_008

You need to indicate whether the table Role is for standard, water or hydrostatic 
deformation.
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NXA83_Configuration_009

Then select Type from Innage, Ullage, Delta innage, Delta ullage or polynomial.

NXA83_Configuration_010

If required, enter a Valid From date in the format 01/04/2011 00:00 (invalid format is 
ignored).

NXA83_Configuration_011

Enter the Reference Height and Shell Capacity.

NXA83_Configuration_012

Finally enter or import the points (up to 60,000) for the tank and then File → Save.

NXA83_Configuration_013
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8.5.4 Importing a Tank Capacity Table
Select Table → Import Points from the menu bar and confirm to proceed.

NXA83_Tank-Capacity-Table_Import

You will be prompted to enter a choice of CSV or Database for the source and given an option 
to change the engineering units for level and volume.
Click the OK button to load the calibration data into the database.
Any problems loading the data will be reported to the user.

NXA83_Tank-Capacity-Table_Import_Source

NXA83_Tank-Capacity-Table_Import_Select

Clicking the Graph button will open a window where a simple chart is plotted showing the 
characteristic of the calibration data. This is a useful aid to spot any erroneous data.
Clicking anywhere on the graph will close the window.
The plotted characteristic should be almost linear for Vertical Cylindrical tanks. For spherical 
and horizontal cylindrical tanks the plotted chart should exhibit a non-linear characteristic.
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NXA83_Configuration_014

Typical graph for a Vertical Cylinder tank

NXA83_Configuration_014

Typical graph for a Sperical tank
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8.5.5 Viewing Existing Tables
Select Configuration → Strap Tables from the main menu.
The Tank Capacity Table module will be loaded.

Select a Capacity Table in order to view the points and data.

Tables which have been superseded using the Valid From field for the date of a new table to 
commence can be seen in the Historical tab.

Editing Values in an Existing Table

Select the table to be edited from the list. If you have the necessary security access rights 
you will be able to edit the table of values.

Type in the new value and move off the row to save the changes locally to the table.

To save the changes press the  button.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.

Inserting an Extra Row

Select the row at which a record needs to be inserted by clicking with the left mouse 
button on the left hand side of the row.

Select the Insert option. 
A new row will be inserted above the selected row.
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NXA83_Tank-Capacity-Table_Edit-Values

Enter the data for the new row.

To save the changes to the database press the  button.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.
Adding is much the same as inserting but appends a row to the end.

Deleting Rows

Select the row which needs to be deleted by clicking with the left mouse button at the 
left hand side of the row.

Select the Delete option.
The row will be deleted.

To save the changes to the database press the  button.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.

4.
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8.5.6 Validity of Data
The user is not allowed to enter points in the wrong order all subsequent levels and volumes 
must be larger than the previous one.

NXA83_Configuration_016

8.6 Alarm Configuration
An integrated part of the Tankvision Multi Scan Configurator application is the Alarm 
Configuration module.

This module provides the user with a multi-tabbed data entry display for the entry and 
configuration of programmable alarms. 

A wide range of programmable alarms have been provided with the Multi Scan NXA83B to 
ensure that the operator/user has sufficient control over product movement. 

All the alarms are organized into logical groups each being assigned a different tab within 
the display.

The main alarm groups are:
• Movement Alarms
• Gauge Alarms
• Programmable Level Alarms
• Programmable Temperature Alarms
• Miscellaneous Alarms

To launch alarm configuration module select Configuration → Alarm Configuration from 
the main menu.
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8.6.1 Launching Alarm Configuration
Select the Alarm Configuration option from the Configuration menu. The following 
display is typical:

NXA83_Alarm-Configuration

Expand the Tank to show the different types of alarms that can be configured. Select one of 
the alarm groups.

Movement Alarms

Use Smoothing for Movement Alarms – Apply smoothing to the volume used to test for 
the Unauthorised Movement Alarm and the Theft Alarm. The smoothing uses the same 
parameters entered for the flow calculations, i.e. Flow Rate Damping and Flow Rate 
Integration. These are entered in the Gauge Configuration screens.

NXA83_Configuration_017

Theft Alarm

This option is currently not supported.
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Unauthorised Movement Alarm

This alarm is often referred to as a Leak Alarm although it applies equally to a gain or a loss 
of product. The Multi Scan NXA83B refers to these as unauthorised movements.

NXA83_Alarm-Configuration_Unauthorised-Movement-Alarm

The unauthorised movement alarm is intended to protect against inadvertent movement of 
product in static tanks. The "Unauthorised Movement by Volume/Level" or Leak Alarm can 
be enabled on systems where the Movements sub-system is not in use. This alarm should be 
enabled when the tank is to remain static, this has the action of internally storing the current 
GSV for the tank, should the GSV in the tank change beyond the predefined threshold limit, 
then the alarm will be triggered. The alarm should be disabled when movement of product 
into or out of the tank is being done.

Threshold – An operator configurable threshold to determine when an Unauthorised 
Movement alarm should be raised.

Flow Alarms

The flow alarms are intended for use when tanks are moving. They are useful to detect that 
flow has exceeded a tank or pipeline design limit or that flow has reduced or stopped perhaps 
due to some fault.

There are upper and lower zone alarms for filling and emptying the tank. The flow 
thresholds for each zone can be set for a rising or falling level.
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NXA83_Alarm-Configuration_Flow-Alarms

By manipulating the zones it is possible to have just one set of alarms.
• Falling – The change from upper to lower zone when emptying a tank
• Rising - The change from lower to upper zone when filling a tank
• Upper zone flow rates – max and min flow rates for the upper zone 
• Lower zone flow rates - max and min flow rates for the lower zone

Upper and Lower zone flow rates are set for both a rising and a falling level.

Gauge Alarms

Gauge alarms are those alarms that are generated by the gauging instrument itself. The 
alarm levels displayed here are normally only there for reference purposes.

On some modern technology gauges it is possible to read the gauge alarm settings from the 
gauge automatically. On older gauges this is not possible however for these devices provision 
is made to enter these manually through this module.

Detection of gauge alarms is performed by the gauging instrument and not by the tank 
gauging software. The system merely reads the status of the alarm bits transmitted to 
it by the gauge. 

Gauge alarm settings are normally set by the gauge commissioning engineer.
• Gauge Alarm High High: The gauge high high level alarm setting
• Gauge Alarm High: The gauge high level alarm setting
• Gauge Alarm Low: The gauge low level alarm setting
• Gauge Alarm Low Low: The gauge low low level alarm setting

Programmable Variable Alarm

The Programmable Variable Alarm is used to trigger an alarm when the level gets above or 
below a set point, dependent upon the direction of flow.

The programmable variable alarm is an additional level alarm provided for use on moving 
tanks, it incorporates a configurable "advanced warning" alarm to indicate that product level 
is nearing the alarm level set point.
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NXA83_Alarm-Configuration_Programmable-Variable-Alarm

The user configurable fields are:
• Enabled – Tick the box to enable the alarms.
• Level – The point at which the level alarm is triggered.
• Hysteresis – Amount by which Level must fall/rise (dependent upon flow direction) to 

cancel alarm.
• Time To Target – Amount of advanced warning before level alarm point will be reached. 

The remaining time is calculated from the flow rate and an alarm will be raised at the 
specified time.

• Time To Target Hysteresis – A hysteresis value to compensate for fluctuations in flow 
rate.

• Direction – Alarms are dependent upon flow direction. Set the arrow to indicate the 
direction of flow; Up for Receipts (tank filling) and Down for Loading (tank emptying). 
Double click on the arrow to toggle direction.

• No Flow Volume – An alarm is raised if the Volume flow rate falls below the value entered 
here.

• No Flow Cons. Time – The "Consideration" time for the No Flow Volume alarm. When a 
movement starts no alarm will be raised for the period specified to allow the flow rate to 
stabilize.
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Programmable Level Alarms

Programmable level alarms are triggered according to the gauged level, they can be used on 
gauges where hardware alarms are not available or used in addition to the gauge hardware 
alarms.

NXA83_Alarm-Configuration_Programmable-Level-Alarms

• Enabled – An operator configurable level alarm enable flag.
• High High – An operator configurable level alarm denoted High High.
• High – An operator configurable level alarm denoted High.
• Low – An operator configurable level alarm denoted Low.
• Low Low – An operator configurable level alarm denoted Low Low.
• Hysteresis – An operator configurable hysteresis value.

The term High High is normally associated with the extreme upper limit to which a tank 
would be filled. Under normal operating conditions it would be unusual to trigger this alarm.

Consequently the term High is not as extreme as High High and is normally set a small 
distance below the High High limit. 

The term Low Low is normally associated with the extreme lower limit to which a tank 
would be emptied. Under normal operating conditions it would be unusual to trigger this 
alarm. 

Consequently the term Low is not as extreme as Low Low and is normally set a small 
distance above the Low Low limit.

Clearly it is essential that all the alarms being used are configured correctly.

The programmable level alarms have equivalent gauge alarms. The programmable alarms 
would normally be set slightly below and slightly above their respective gauge alarm values. 
The programmable alarms would normally be used as early warnings to the gauge alarms. 

However the user can choose to use them as required although it is recommended that they 
are used within the context of the definition of the alarm to avoid confusion. 
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Programmable Temperature Alarms

NXA83_Alarm-Configuration_Programmable-Temperature-Alarms

These are operator programmable temperature alarms.
• Enabled – An operator configurable temperature alarm enable flag.
• High – An operator configurable high temperature alarm.
• Low – An operator configurable low temperature alarm.
• Hysteresis – An operator configurable temperature hysteresis value.

Programmable Water Alarms

Water alarms are triggered when tank water levels exceed the limits specified. If you do not 
require a low water alarm, set the low level to a negative value.

• Enabled – An operator configurable water alarm enable flag.
• High - An operator configurable free water level, above which the alarm will be triggered.
• Low - An operator configurable free water level, below which the alarm will be triggered 

- If a low water warning is not required this may be set to a negative value to prevent it 
occurring.

• Hysteresis – An operator configurable free water level hysteresis value.

Difference Alarms

For applications where an accurate product level measurement is critical a tank may have 2 
level gauges. One gauge will be nominated as Primary duty with the other as a Secondary 
gauge.

The Multi Scan NXA83B will monitor the level returned from both gauges and can check for 
a difference between the two gauge levels. If the difference exceeds the tolerance entered 
for this alarm a difference alarm will be generated.
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NXA83_Alarm-Configuration_Difference-Alarm

The configurable fields are:
• Enabled – Tick to enable the alarm.
• Maximum Difference – Enter the maximum allowable difference between the 2 gauge 

levels.
• Hysteresis – An operator configurable level difference hysteresis value.

Deviation Alarms

The deviation alarm is used to alert operators to layering occurring in the tank. When two 
consecutive profile points deviate by the specified amount, either in their density readings 
or temperature, an alarm will be generated. This alarm requires the use of gauges capable of 
returning density profiles.

The configurable fields are:
• Enabled – Tick to enable the alarm
• Density Profile Deviation – Maximum deviation between consecutive density points.
• Temperature Profile Deviation – Maximum deviation between consecutive temperature 

points.

Programmable Density Alarms

These are operator programmable density alarms.

The configurable fields are:
• Enabled – An operator configurable density alarm enable flag.
• High – An operator configurable high observed density alarm.
• Low – An operator configurable low observed density alarm.
• Hysteresis – An operator configurable density hysteresis value.

Floating Roof Alarm

The purpose of the Floating Roof alarm is to provide the operator with the option of 
generating a warning when the product level starts to approach the point where the roof 
starts to rest on its legs. Under normal operating conditions this is generally undesirable; 
therefore the alarm has been provided for that purpose.

The configurable fields are:
• Enabled – When selected, the Floating Roof Alarm will be activated when the product 

level falls below the Roof Early Warning Level. The alarm will be cleared when the product 
level rises above the Roof Early Warning Level by more than the Roof Warning Hysteresis.
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• Roof Early Warning – An operator configurable set point determining at what level the 
alarm will be generated. The level would normally be programmed above the Roof Fully 
Floating level set in the Tank Characteristics module.

• Roof Warning Hysteresis – The operator configurable distance by which the product level 
must return above the Roof Early Warning Level in order to clear the Roof Early Warning 
Alarm.

8.6.2 Modifying Data Within Alarm Configuration
All alarms are tank specific. If the same alarms are required for more than 1 tank, they 
will need to be configured for each tank.

Open the Alarm Configuration window and select the tank from the list on the left. 
Select the type of alarm to be modified for this tank.
The current details for the alarm for that tank will be displayed.
The Multi Scan NXA83B comes supplied with a set of default alarm parameters pre-
configured. The first time Alarm Configuration is loaded after installing the system it 
will display the default values. These default values should be replaced with the correct 
operating values prior to commissioning the system.

Select the field to be edited and enter the new data values. The TAB key may be used to 
move to the next entry field or selection can be made using the mouse.
Each field is validated both during data entry and just before the data is saved to the 
database.

Once the changes are complete and correct, they can be saved by clicking the OK button. 
This will save the changes and close the window. To save the changes and continue to 
edit the database click the Apply button. It is not necessary to save the changes to one 
alarm before editing another but it is best practice to do so.

To edit further tanks follow the same procedure.

When all necessary configuration has been completed, the changes can be saved and the 
Alarm Configuration window closed by clicking the OK button. The window can be 
closed and changes can be abandoned without saving by clicking  or the Cancel 
button, however any changes already saved will be retained.

8.6.3 Generation of Alarms
Normally in a standalone configuration the alarms are detected and generated by the Data 
Communications Control module. It is this module that sees the changes in gauge data first. 

In a client-server system it is the same module that detects and reports the alarms although 
it is important to note that this module will only be running on the server. 

Any client connected to the server will therefore see the same alarms. 

Some events may be generated locally by each client. These are normally events in response 
to abnormal operating data or transient or irrecoverable data access errors.

Enabling and Disabling Alarms

When an alarm is Enabled, the variable associated with the alarm is monitored against its 
set limits. If the variable deviates outside of the set limits an alarm will be generated.

When an alarm is Disabled, no alarm processing will take place for the disabled alarm and 
therefore no event, audible signal or otherwise will be generated if the variable deviates 
outside of its set limits.

The alarm configuration display provides a check box within each tab for enabling or 
disabling the alarm.

4.

5.
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8.7 Manual Data
Normally tank data is collected from the field instruments automatically.

Where primary data values are not available or no longer available due to a gauge fault, data 
values may be switched from automatic mode to manual mode.
When in manual mode the data values must be provided by the operator.

Data that is in manual mode is normally displayed with green text on black background to 
signify that it is manual data. On reports it is normally suffixed with the letter M. 

Where tanks are not fitted with gauges but are still required on the system, the tank may be 
operated with all of its primary data values in manual mode. In this way the tank inventory 
is calculated from the manual data.

Note that gauges that have both level and temperature in manual mode will not be 
polled by the communications layer.

Primary data values are those measurements made by the tank gauging instrument such as:
• Product Level
• Water Level
• Product Temperature
• Product Density
• Pressure

Traditionally, most gauges provide Product Level and Product Temperature measurement 
capability. It is quite common to find that the rest are entered as manual data. 
More modern gauging instruments have the capability to measure water level, density and 
pressure automatically. In this case the values would be collected automatically. 

The use of this feature can be controlled by the security system.

8.7.1 Launching the Manual Data Entry Module
In order to enter Edit mode and modify manual data values users must be logged on with the 
correct access rights. To access manual data configuration, from the main application 
window select Configuration → Manual Data.
The following display is typical of what will be loaded.

NXA83_Manual-Data
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A list of all tanks will be displayed on the left, together with the manual data entry fields for 
the selected tank. 
By default a reduced set of the most common fields will be displayed.
To view the additional fields for a tank click on the Advanced button  .

By default any changes to the manual data for a tank will apply to ALL gauges on that tank.
The individual gauges assigned to a tank can be viewed and edited by clicking on the Show/
Hide_gauges button .

In this mode the manual data can be configured for individual gauges.

NXA83_Configuration_018

8.7.2 Entering Manual Data
Select a tank/gauge from the list and edit the required parameter. 

If the field is not already in manual mode tick the Enabled box at the start of the line.

After all required data has been entered; Click on the OK button to save the changes to the 
database and exit the application. Click on Apply to save the changes and continue editing.

Click on the Cancel button to discard any changes and exit the application.
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8.8 Product Configuration
When first installed the system has no product information.
This function is used to enter the names of the products stored on site.
Product Configuration can be launched at any time in order to edit existing products, delete 
products or to add new products.

Each product must be allocated to a product group. By default, a GENERAL product group 
exists. Other Groups may be created as required. 

8.8.1 Product Groups
Product Groups allow the user to group together products that have similar characteristics.

For example, Product Groups might be configured as:
• DISTILLATES
• SPIRITS
• CRUDE
• HEAVY OILS
• FUEL OIL

The following products may for example be members of the DISTILLATES product group:
• DERV
• KERO
• GAS
• OIL
• JET A1

Similarly, the following products may be members of the SPIRITS product group:
• ULMS
• LRP
• UL 95
• UL 98

And so on.
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8.8.2 Launching Product Configuration
Select the Product Configuration option from the Configuration menu. 

The following display is typical:

NXA83_Product-Configuration

Enter the product groups as required. 

To enter a new Product Group:

Click the Product Group toolbar button .

Enter the name of the new product group.

Click the Apply button to save the new group to the database.

To edit an existing group:

Select the group to be edited.

Modify the Group name.

Click the Apply button to save the changes to the database.

To delete an existing group:

You can only delete a group when it contains no products.

Select the group to be deleted.

Click the Delete button .

Click the Apply button to confirm delete.

Click the Cancel button to abort the delete.

To enter a new product:

Select the Group where the New Product will be added.

Click the New Product button  on the tool bar.

4.
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NXA83_Product-Configuration_New-Product

Type the name of the new product. This field is limited to 30 characters.

Choose a new color for the product.

The use of color is determined by options configured in the System Settings module. 
Please refer to a description of these settings for further information.

Click the Apply button to save the new product to the database.

The new product will be allocated to the selected group. To allocate the product to a tank, 
refer to details in the Tank Characteristics section (→ ä 42).

To delete an existing product:

If the selected product is currently in use, the Delete command will be rejected. You 
must remove all use of the selected product before it can be deleted.

Select an existing product. The current configuration details will be displayed.

Press the Delete button  on the toolbar. The product will be removed from the 
database.

Press the Cancel button to discard any changes.

8.8.3 Allocating Products to Tanks
The Tank Characteristics module is used to allocate a product to a tank.

See the section detailing the Tank Characteristics module (→ ä 42) for a full and complete 
description.

4.

5.
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9 Display Configuration

9.1 Tank Data Displays
As an optional feature, the Tankvision Multi Scan NXA83B is equipped with a 7 in LCD 
touchscreen display which is used to view the live data from any tanks configured in the 
database. Navigation around the different displays is by selection of the touchscreen 
buttons.

The display can show data to in a number of different formats:
• Grid View display of multiple tanks
• Single Tank graphical display
• Multi Tank graphical display
• Reports of multiple tanks

A range of different displays can exist for each format, which may be selected for viewing by 
the operator.

These displays must be configured in the Tankvision Multi Scan Configurator software 
before being downloaded to the NXA83B device. 

The configurator user is free to select from a range of data fields to display, such as level, 
temperature, density etc. Other features such as pictures, bar graphs, alarm displays, text 
label and selector buttons may also be displayed.

9.2 Display Configuration
The Multi Scan NXA83B has the capability to configure three categories of display:
• Single Tank Displays
• Multi Tank Displays
• GridView Displays

The first two use a SCADA editor to configure the displays. This makes them highly 
adaptable, enabling displays to be configured to exactly match user requirements. 

GridView displays are equally configurable but use a grid layout to display data. These will 
be covered in a later section (→ ä 93).

There is no limit to the number of displays that can be configured.

To open the display editor open the Configuration menu and select the type of display to 
create or edit.
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NXA83_Configurator_Configuration_Displays

1 Three categories of display: Single Tank, Multi Tank, GridView

The display selection screen will be displayed for the type of display chosen, this will show a 
list of all currently configured displays, e.g.

NXA83_Configurator_Single-Tank-Overview

The text is the name that will be displayed in the menu on the Multi Scan NXA83B display 
screen. This can be changed when the display is edited.
The item in brackets is the actual name of the configuration file for the display, for instance 
(display.sto).

9.2.1 Adding a display
To add a new display:

Open the Configuration menu.

Pick the category of display required.

Click on the Add button. A new display editor will start.

1
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Configure the display as required.

When complete, save the display to a new file name.

A new item will be displayed in the list of displays.

9.2.2 Deleting a display
Once a display is deleted it cannot be restored, so be sure before deleting any display.

To delete the different types of displays:

Select the Configuration menu and pick the category of display required.

Select the display to be deleted and click on the Delete button.

9.2.3 Editing a display
To edit the different types of displays:

Select the Configuration menu.

Select the category of display required.

To edit a display select the item in the list and then click on Edit.

This will open the display editor for this file.

9.2.4 Setting the DEFAULT display
One display of each type will be marked with [DEFAULT SCREEN]. This is the display that 
will be initially loaded when the Multi Scan NXA83B boots up.

To change the default screen, select the new screen and click on the Set as Default button.

9.3 Single Tank and Multi Tank displays
The Multi Scan NXA83B single tank and multi tank displays are completely flexible for the 
data to be shown on the screen. They are configured using the Tankvision Multi Scan 
Configurator software.

A display may be configured for a range of items, including:
• Live Data Fields – For measured data such as Level, Temperature, Pressure, Density, 

Water Level etc. May also includes calculated data such as Volumes, Mass etc.
• Data Entry Fields – For manual data, alarm setpoints etc.
• Fixed Text Labels
• Bar graphs – For showing percentage level etc.
• Pictures
• Alarms
• Graphs – For Multi-element temperatures, profiles etc.

Each field can be customized for size, color, fonts etc. 

Single Tank Displays only display data for gauges from a single tank name. The configured 
screen becomes a template for what to display, therefore display fields cannot be configured 
for a specific Tank and only the gauge duty may be specified. The tank is specified at runtime. 

Multi Tank Displays are fixed displays where data from multiple tanks can be displayed on 
the same screen. All display fields must have the tank name and duty defined at the time of 
configuration.

4.

5.
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9.3.1 Display Editor
The Single Tank/Multi Tank Display editor is started as described in previous section 
(Display Configuration).
The editor allows all displays items to be configured as required.
All items shown in the editor are configurable and the layout is free-form, therefore items 
may be placed anywhere on the screen.

The following areas should however be avoided:
• Top right hand corner: The fixed Tanks selector button goes here in normal operation
• Top left hand corner: The fixed Screens selector button goes here in normal operation
• Bottom line: The status display field goes here

NXA83_Display-Editor_Avoid

1 Area for fixed Screens selector button
2 Area for fixed Tanks selector button
3 Area for status display field

9.3.2 Modifying an existing item
To modify an existing item in the display, first click on the item.
The item can be moved around the screen by holding down the left mouse button and 
dragging it to the new location. 

The item can be re-sized by dragging the edge/corner to the new size. Certain items, such as 
pictures, can only be resized if the Stretch flag is enabled in its configuration menu.

To edit the configuration of an item right click on it, and select the option from the pop-up 
menu.

1 2

3
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NXA83_Display-Editor_Edit-Item

The options contained within the menu will depend on the display item being edited. On 
individual display items → ä 87.

9.3.3 Adding a new item
To add a new display item, right click on a blank section of the editor and select Add Item. 
Then select an item from the list.

NXA83_Display-Editor_Add-Item

The new item will be added to the top left corner of the editor and can now be modified as 
detailed above.
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9.3.4 Setting the Display Name
The display name is the text that will be displayed in the menu when selecting the display 
on the Multi Scan NXA83B.

To set the name, right click on the background of the display (not on any field) and select 
Text from the pop-up menu. The Display name can be entered in the text box.

NXA83_Configuration_019

9.3.5 Changing the display units
The display units for all data items may be configured by right clicking on a blank section of 
the editor and selecting Units from the drop down menu.

NXA83_Configuration_020

The units and number of decimal places for each data type may be configured and are then 
used in the Multi Scan NXA83B to format all live data in the display.
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9.3.6 Changing the background color
The background color for the display may be configured by right clicking on a blank section 
of the editor and selecting the Back Colour menu option.

NXA83_Configuration_021

The Select option allows the colour to be defined, or set to Use Default if the normal system 
background is to be used.

9.3.7 Copy, Paste & Select All
To copy an item, right click on the item and select Copy from the pop up menu.
To paste an item that has been copied, right click on a blank section of the editor and select 
Paste from the pop up menu. The new item will be pasted into the top left corner of the 
editor and can now be modified as previously described.
Select All will select the entire contents of the editor. This is useful for performing global 
changes such as type font or item colour, or for duplicating large amounts of display data. To 
select all items, right click on a blank section of the editor and click Select All in the pop up 
menu.

9.3.8 Resize to fit
This command cannot be undone so it is recommended that a copy of the file is saved 
first.

When creating a display screen it may be desirable to eliminate any blank space around the 
edges of the screen. The Multi Scan NXA83B provides a tool to do this.
To resize the screen, cropping out all blank parts of the background to fit the current screen 
size right click on an blank section of the editor and select Resize to fit from the pop up 
menu.
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9.3.9 Saving the display
To save the display configuration, either close the Display Editor or right click on a blank 
section of the editor and select Save from the menu.
In both cases a pop-up window will appear prompting for confirmation to save the display. 
Click Yes to save or No to abandon any changes and exit.

NXA83_Display-Editor_Save-before-Exit

The display is saved to a file of type .sto and the file name and destination can be specified. 
Although the file can be saved in any location, it must however be saved in the default 
Config folder for the Multi Scan NXA83B to access and use the file.

NXA83_Display-Editor_Save-As

1 Safe as Screen: New file name

If a new file name is specified in the Save As screen (i.e. a new file name) then a new display 
will be added to the list of single tank displays. The changes will not have been saved in the 
original file.

1
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NXA83_Display-Editor_Single-Tank-Overview

1 Single Tank Overview: New display

To overwrite an existing file, select the file from the Save As screen and click Save. A pop up 
window will appear prompting for confirmation to replace the existing file. Click Yes to 
proceed.

NXA83_Display-Editor_Save-As_Replace

9.3.10 Display Items

Display Items

The display may be configured with range of different items, including:
• Label: A fixed text field.
• Picture: A fixed picture displayed on the Multi Scan NXA83B screen.
• Button: A link to run an executable program.
• Command Button: A configurable shortcut to run a gauge command.
• Group: A field used to group together a number of other items.
• Data → Tank: A field used to display live data, specific to a single tank, from the Multi 

Scan NXA83B. It is dynamic and will be refreshed periodically.
• Data → Product Totaliser: A field used to display live data, specific to a single product. 

The total amount is calculated from all tanks containing the specified product. It is 
dynamic and will be refreshed periodically. This field is only applicable to Multi Tank 
Overview (.mvo) displays.

• Flood: A simple vertical bar graph. The bar graph displays product level as a percentage of 
tank height. It is dynamic and will be refreshed periodically.

• Flood → Product Totaliser: A simple vertical bar graph that displays the total amount of 
a single product calculated from all tanks containing the product. The bar graph displays 
product level as a percentage of total capacity of all tanks containing the specified product. 
It is dynamic and will be refreshed periodically. This field is only applicable to Multi Tank 
Overview (.mvo) displays.

• Alarm: Displays an alarm icon on the screen when any alarm is active for the tank. If no 
alarm is active, the icon disappears.

• Tank Picture: This is the same as a picture except that a separate image can be specified 
for each of the four tank shapes. When a tank is selected, the picture displayed will be 
determined by the shape of the tank configured in the database.

• Valve: Not supported on the Multi Scan NXA83B.
• Pump: Not supported on the Multi Scan NXA83B.

1
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• Data Entry: Similar to a data field except that instead of live data, data is entered bu the 
operator. This is useful for applications such as manual data (product level, temperature 
etc.) and setting alarm trigger points which cannot normally be altered whilst the Multi 
Scan NXA83B is live.

• Graph: A display item that shows live data in a graphical format. It is dynamic and will be 
refreshed periodically.
Graphical data available is:
– Multi-element Temperatures
– Skin Temperatures
– Profile Temperatures
– Profile Densities
– IO Block Data

After adding a display item it must be configured for use. The attributes that can be 
configured depends upon the item and whether it is assigned to a Single or Multi tank 
display. To access the configuration attributes, right clicking the item in the display editor.

Item Attributes

Below is a list of all configurable attributes.
• Align: Aligns the text or picture within the item field to one of nine positions. The text/

picture can be located within the item box only.
• Arguments: Values to be passed to an executable program.
• Color: Sub menu for item colour options. There are four possible options depending upon 

the item being configured:
– Transparent: Makes the label transparent so that only the text is visible.
– Fore Color: Sets the text colour.
– Back Color: Sets the Background colour.
– Border Color: Sets the border colour for the display item.

• Command: Used to specify the gauge command for command buttons.
• Data: Used to specify the type of data, from a drop down menu, to be read into the display 

item. This can be live or manual depending upon the item. Data can be in 1 of 3 states 
Normal, Manual and Invalid. Each may be configured to have a different appearance for 
colour and alignment.

• Decimal Places: Specifies the number of decimal places to display.
• Display: Sub menu used to select what characteristics are displayed within a data field. 

The following may be enabled:
– Show Operating Levels: Tick to display the tank operating levels on flood fields.
– Data: Tick to display the actual data value, otherwise no data will be displayed. This is 

normally ticked.
– Units: Tick to display units after the data value, otherwise no units will be displayed.
– Gauge Commands: Tick to show the gauge commands selector screen when the item is 

selected. If an item is in manual mode the manual entry screen will be displayed if this 
option is enabled.

– WM Status: Tick to display the Weights and Measures status of the data. This field is 
composed of a number of characters to show the current status of the data. Values 
include:
– ’&’ – data is manually entered
– ’S’ – data is stored, i.e. level when gauge is not following level etc.
– ’#’ – data is not W&M approved

– Default Decimal Places: Tick to format the data with the default decimal places for the 
units selected (to set default decimal places → ä 84)

• Executable: Select the executable program for button.
• Font: Used to set the font, size and style (bold, italic and underline) of the text.
• Graph: Sub menu for the graphical display to set the following items:

– Show Grid: Tick to show the gridlines on the graph, otherwise none will be shown.
– White Background: Tick to make the background of the graph white, otherwise it will 

be grey.
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– Minimum Range: Used to set the minimum range to be displayed on the x=axis of the 
graph.

• Order: Sub menu. Items can be placed on the screen such that they overlap each other. The 
order that the items will be displayed is determined by pushing items to the back or pulling 
them to the front. There are no intermediate stages; items can only be sent to the back or 
to the front. Multi-layer ordering can be achieved by careful selection of the order that 
items are moved.
– To Front: Moves the selected item to the front of the group.
– To Back: Moves the selected item to the back of the group.

• Output Value: Defines the value to be passed to the specified data field when a command 
button is activated.

• Picture: Opens a navigation window to select a picture to display.
• Picture: Sub menu. This option is used for selecting and configuring pictures as 

backgrounds for buttons and labels. The following are configurable:
– Show: Tick to include a picture as a background.
– Picture: Opens a navigation window to select a picture to display.
– Align: Aligns the picture to one of nine positions within the button or label.

• Product Name: Used to select a product from a drop down menu of configured products 
when setting data and flood totaliser fields.

• Pump ID: This feature is not supported in the Multi Scan NXA83B.
• Stretch: Unlike all other items pictures cannot be resized by "click and drag" of the picture 

field. Resizing the picture field will result in a white border (the field cannot be smaller 
than the picture). Ticking the stretch command will cause the picture to "Stretch" to fit the 
size of the picture field.

• Tank ID: In Multi tank displays (.mto) this is used to specify which tank and gauge duty is 
to be applied to an item. In Single tank displays (.sto) where there can only be one tank 
(specified at run time) this option is only used to specify the gauge duty.

• Text: This option opens a window for defining the text to be entered into items.
• Valve ID: This feature is not supported in the Multi Scan NXA83B.
• Visibility: Sub menu. Items can be configured to only be visible under specific conditions. 

The options for configuring visibility are:
– Always visible: Tick this option to override visibility conditions. This option is selected 

by default.
– Tank ID: Select a tank and gauge duty, e.g. Tank1 primary gauge
– Data: Select a data value to test against, e.g. Product level
– Test_value: Set the condition that needs to be met to display the item, e.g. greater than 

5000.
The example above could be used to display an alarm icon if the Product Level in Tank1 
exceeds 5000 mm.

Item menus

NXA83_Configuration_022
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Label

NXA83_Display-Editor_Item-menus_Label

Picture

NXA83_Display-Editor_Item-menus_Picture

Button

NXA83_Display-Editor_Item-menus_Button
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Command Button

NXA83_Display-Editor_Item-menus_Command-Button

Group

NXA83_Display-Editor_Item-menus_Group

Data → Tank and Data → Product Totalizer

NXA83_Display-Editor_Item-menus_Data_Product-Totalizer
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Flood → Tank & Flood → Product Totalizer

NXA83_Display-Editor_Item-menus_Flood_Product-Totalizer

Alarm

NXA83_Display-Editor_Item-menus_Alarm

Tank, Valve and Pump

NXA83_Display-Editor_Item-menus_Tank-Valve-Pump

Data Entry

NXA83_Display-Editor_Item-menus_Data-Entry
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Graph

NXA83_Configuration_023

9.4 Grid View and Reports
GridViews and Reports use a grid layout to display data either on screen or on paper (in the 
case of reports).

A range of Grid Views and Reports may be configured using the Tankvision Multi Scan 
Configurator tool, using a common set of configuration screens.

Reports may also be configured to be automatically printed at scheduled times. 

Grid Views and Reports are completely configurable. This makes the grids highly adaptable, 
enabling GridViews and Reports to be configured to exactly match user requirements.
Since GridViews are configured in exactly the same way as GridView Reports without the 
additional features of printing and report scheduling, this manual will only deal with 
GridView Reports.

The grid can be customized for:
• the number of columns
• the tanks to be displayed
• column totals
• flow colours
• grid title text and font

Each column in the grid can be formatted for:
• Live Data such as Level, Temperature, Pressure, Density, Water etc.
• Width
• Font
• Header Text

A report may also be configured for print layout, including:
• Landscape/Portrait
• Margins

Various different Grid Views and Reports can be configured for a Multi Scan NXA83B.
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9.4.1 GridView Report Editor
To start the Grid View Reports editor select Configuration → GridView Reports 
(Configuration → GridView Displays for the display editor) from the Multi Scan NXA83B 
configurator.

NXA83_Report-Configuration_GridView-Report-Editor

Select the report to edit or select Add to create a new GridView.
The report editor screen will open. The editor allows all parameters to be configured for the 
selected grid view report.

NXA83_Report-Configuration

Configuration is split into three sections for GridViews plus an extra two for Reports:
• Grid: Sets global parameters for the grid, such as Caption, Fonts colors etc.
• Filter: Sets the criteria for selecting the tanks to be shown in the grid.
• Report Printing: Sets report specific layout parameters, such as Landscape and Margins. 

(Reports only)
• Report Scheduler: Sets automatic print parameters. (Reports only)
• Columns: Sets the columns to be shown in the grid.

To edit a section, select the relevant heading from the list on the left of the window. The 
appropriate data will be displayed in the right hand panel.
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9.4.2 Grid
Click on the Grid item to edit parameters that affect the whole of the grid.

NXA83_Configuration_024

The following parameters may be configured:
• Caption: This is the title for the report, displayed at the top of the screen. It is also the 

name used to select a report to be printed/displayed.
• Caption Font: Click on the Edit button to select the font to use for the caption.
• Font: Click on the Edit button to select the font to be used for all data in the grid, including 

column header text.
• Totalise Columns: If ticked any volume, mass and weight column will be totalized and 

displayed at the bottom of the column. The text box to the right allows the row name to be 
entered. This defaults to "Totals" and will be displayed in any "Tank ID" column.

• Use Color: (Displays only)
• Use Color to Indicate Flow Direction: When ticked, rows in a grid will change color to 

indicate flow direction in moving tanks. The following colors are used: Brown to indicate 
an emptying tank and Blue to indicate a filling tank (Displays only).

• Use Color For Values in Alarm: When ticked, any values which are in a state of alarm will 
be shown on a Red background (Displays only).

• Units: Clicking on this item will display the units edit box. This allows the units of all data 
items to be set. The units only apply for this grid.

NXA83_Report-Configuration_Grid_Dimensions
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9.4.3 Filter
Click on the Filter item to edit parameters that determine which tanks will be displayed in 
the grid.

NXA83_Report-Configuration_Filter

The following parameters may be configured:
• Filter: This sets the mode to determine which tanks are displayed in the grid. Currently 

supported filter modes are:
– All Gauges: All tanks will be displayed in the grid, in the order that they appear in the 

database configuration.
– By tank ID: Only those tanks that are in the Devices list will be displayed in the grid.
– Product: Only those tanks that contain the product named in the Product field will be 

displayed in the grid, in the order that they appear in the database configuration.
• Product: If the Filter mode is Product, this field will be enabled to allow the product type 

to be entered.
• Primary Gauge: If ticked only Primary gauges will be included in the grid
• Devices: If the Filter mode is By tank ID, this section is enabled. A list of specific tanks can 

be entered for display in the grid. The order that tanks appear in this list is the order that 
they will be displayed in the grid.

Clicking on the Add Gauge button opens a window for selecting a tank to be included in the 
device list.

NXA83_Report-Configuration_Filter_Add-Gauge

Filtering by Tank ID only uses the Tank ID to determine what data to display. The Gauge 
Duty section is not used. If the Primary Gauge box is ticked only primary gauges will be 
displayed for the selected tanks, otherwise all gauges for these tanks will be displayed.

Click OK to add the tank. 
Clicking on the Delete Gauge button will delete the currently selected device.
Clicking on the Delete All button will delete all of the devices.
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9.4.4 Report Printing
Click on the Report Printing item to edit parameters that determine how a report will be 
displayed on the printout.

NXA83_Report-Configuration_Report-Printing

The following parameters may be configured:
• Landscape: If ticked the report is printed as Landscape, otherwise it will be printed as 

Portrait.
• Show Grid: If ticked the grid lines will be shown on the report.
• Center Grid: If this is ticked the report will be centred on the page.
• WM Approved: If ticked the report shows the weights and measures approval status of the 

Multi Scan NXA83B.
• Margins: This section allows the margins for the printout to be defined.

9.4.5 Report Scheduling
Click on the Report Scheduler item to edit parameters that determine when a report will be 
automatically printed.

NXA83_Report-Configuration_Report-Scheduler
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The following parameters may be configured:
• Mode: This sets the mode for print scheduling of the report. Choose from:

– None: The report will not be printed automatically. Manual printing is still possible
– Hourly Trigger: The Minutes field is enabled. The report will be printed every hour, at 

the specified Minutes past the hour.
– Daily Trigger: The Hours and Minutes fields are enabled. The report will be printed 

once per day, at the specified time.
– Weekly Trigger: The Day of Week, Hours and Minutes fields are enabled. The report 

will be printed once per week at the specified time.
• Day Of Week: This is a drop down menu for selecting a weekday.
• Hours: This is a dropdown menu for selecting an hour. The report scheduler uses the 24 

hour clock.
• Minutes: This is a dropdown menu for selecting minutes past the hour.

9.4.6 Columns
Click on the Columns item to edit parameters that determine what data columns will be 
displayed in the grid.
A representation of the grid will be displayed in the lower portion of the screen. This is the 
actual grid layout that will be displayed on the Multi Scan NXA83B, but without the tank 
data rows.

To insert a new column select a column in the grid next to where the new column is required 
and click on the Insert button. This will add an exact copy to the right of the selected column. 
The parameters may then be edited as required.

To edit a column, click on that column in the grid display.

NXA83_Report-Configuration_Columns_Edit

The column in the grid display will be displayed with DN00 in red, to indicate that the 
column is selected. The panel above it will display the current parameters for that column.

Click on a field to edit its contents.

The following parameters may be configured for each column:
• Column Header Text: This is the text that will be displayed at the top of the column. Click 

within this field to edit the text using the keyboard.
• Data: This is the data field that will be displayed in the column. Click on the Edit button to 

display a pop-up window and select from the drop down menu.
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• WM Status Column: If this box is ticked, the column will display the WM status characters 
for the selected data instead of the data.

• Width: This field setsthe width in pixels for the column. Click within this field to edit the 
value using the keyboard. Any changes to this value will be immediately reflected in the 
grid. Note that the full width of the Multi Scan NXA83B display is 640 pixels.

• Align: This sets the alignment of the data in the column.

Columns can be removed by selecting the column and clicking the Delete button.

9.4.7 Saving the configuration
To save the configuration, close the window with the  button.
A prompt will appear asking if the configuration is to be saved.

NXA83_Report-Configuration_Columns_Exit-Prompt

Click No, to discard any changes and exit, or Yes to display the Save As dialog.

NXA83_Report-Configuration_Columns_Save-As

A GridView will be saved to a file type of .gvo, whilst a report is saved to a file of type .gvr 
and the file name and destination can be specified. 

To function on the Multi Scan NXA83B, the file must be stored in the Config folder.

Click Save to permanently save the new configuration. 

If a new file name is specified, the configuration data will be saved to the new file and a new 
screen will be added to the list of gridviews or reports. The original file will not be changed.
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10 System Settings

10.1 System Settings
System Settings are options and settings that affect the operation of the entire Multi Scan 
NXA83B system. The System Settings screen is available under the Admin menu.

The options that can be configured within System Settings are:
• Login Enabled
• Sound Enabled
• Voice Enabled
• Use Product Colours
• Movement Threshold

10.2 Using System Settings
Select the Admin → System Settings option from the main menu bar. 
The System Settings display will be loaded.

NXA83_System-Settings

To change any system settings you must be logged on as a user with administrative 
privileges.

To change System Settings:

Either tick/untick a box or enter the required value into the field.

Click on the OK button to close the window and save the changes to the database or the 
Cancel button to abandon the changes and exit.

10.3 Login Enabled
Determines whether users are required to enter passwords to access and modify the system.

If this option is ticked the Multi Scan NXA83B will require users to log in to access password 
protected controls. If users are not logged in, or do not have sufficient access rights the 
following dialog will pop up.

NXA83_System-Settings_Insufficient-user-rights

If this occurs click OK and log in with sufficient rights to continue.
If log in is not enabled, there will be no access restrictions.
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10.4 Sound Enabled
This determines whether sound is enabled. Currently only voice messages are supported by 
this feature. To enable this feature, tick the box.

10.5 Voice Enabled
This determines whether voice messages are enabled.

If this option is ticked the voice messages, where available, will be played for the alarms and 
warning that occur as part of normal tank gauging operations.

10.6 Use Product Colors
This determines the strategy for colour in the tank flood panes.

Currently the Multi Scan NXA83B does not support this feature.

When ticked the color representing the product level in the tank will always be Blue.

When not ticked the colour of the product is represented by the tank status. For example, if 
the tank is filling, the color of the product is displayed as Blue; if the tank is emptying, the 
color of the product is displayed as Brown; and if the tank is static, the color is displayed as 
Green.

10.7 Movement Threshold
This determines the minimum flow rate level that is deemed significant enough to mark a 
tank as moving.
A default flow rate of 5 mm/min is considered adequate for most Multi Scan NXA83B 
installations; however any user defined value may be entered.
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11 Security
The Tankvision Multi Scan Configurator software is provided with its own security and user 
administration functions. It is not dependent on Windows system security for access to its 
features. 

The security database is stored for each Multi Scan NXA83B device and loaded when a 
project is loaded. 

The User Configuration module is present in the Admin menu. 

The security features should be used carefully to ensure users have the correct access rights 
for their tasks and to prevent unauthorized access to the system. 

To logon as a user select Security → Login.

NXA83_Security-Login

The Login screen allows the User name and Password to be entered. 

To log off from the current user then select Security → Logout.

11.1 Using Security Configuration
Log on to Tankvision Multi Scan Configurator software as an administrator.

Select the User Configuration option from the Admin menu.

The default security display will be loaded. All the current user details will be listed in a 
tabular form.



Tankvision Multi Scan NXA83B Security

Endress+Hauser 103

NXA83_User-Configuration

After installing the software only one account will exist. This is the Administrator account 
and it will have a default password of "password". It is recommended that this is changed to 
a more secure password as soon as possible.

The table is a matrix of users against their logon rights. The columns indicate the 
characteristics of the users account, and the rows represent the different users. It is therefore 
possible to deny or grant a level of access on a per feature basis (i.e. User A may be denied 
access to the Tank Characteristics module, User B may be granted Read Only access, and User 
C may have modify privileges).

The fields are defined as follows:
• User Name: Text entry field for user’s name. This will be displayed on the Home Page 

when the user is logged on.
• User Initials: Optional text entry field for an abbreviated version of the user name. This is 

a reference only field that is not used by the Multi Scan NXA83B.
• User Group: Text entry field for the group a user belongs to. This is a reference only field 

that is not used by the Multi Scan NXA83B.
• Password: Text entry field for the password of the user.
• Login Timer Enabled: Determines whether the user account will time out after a period 

of inactivity.
• Login Timer Timeout Time: The time of inactivity required before the user account times 

out and the user is logged out.

The remaining columns each reflect a feature or function within the Tankvision Multi Scan 
Configurator software. Each cell has a drop down menu to select the level of access a user is 
permitted for that feature.

The following access levels are currently available for each feature:
• No Access
• Read only
• Modify
• Create
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• Delete
• Full Access

The following software buttons are provided:

11.2 Creating a new User Account
Log on with sufficient access rights. Select Admin → User Configuration from the main 
menu bar.

Click the New button. A new row will be added to the table.

Use the mouse and cursor keys to configure the rights of the new user.

NXA83_User-Configuration_Adding-New-User

The following data entry fields are mandatory:
• User name (maximum of 20 characters)
• Password (minimum of 6 characters)

All the feature access rights will default to No Access if nothing else is specified.

Various different users can be added to a system.

Button Function

Edit Click to edit existing user accounts.

New Click to create New user accounts.

Copy Click to copy an existing user account.

Delete Click to delete an existing user account.

Cancel Click to abandon any changes.

OK Click to confirm changes.

Exit Click to close the display.
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To specify user rights for each feature scroll to the relevant column and select from the 
drop down menu.

Alternatively, an existing user account can be copied to create 1 or more new accounts.
Select an account by clicking the start of the row and click the Copy button.

NXA83_User-Configuration_Copy

A dialogue box will open requesting the number of copies required.

NXA83_User-Configuration_Copy_Number-of-copies

Enter the number of copies and click OK. These will be added to the bottom of the grid and 
will contain exact copies of the selected user’s access rights. The first 4 fields are User 
specific so are left blank to be completed with unique details.

The OK button will be enabled when any changes have been made to the configuration. 
To save the new user account to the database, click the OK button.
Provided all fields are supplied in the correct format, the data will be saved to the 
database. Any problem occurring whilst the data is being saved will be reported to the 
user via the display’s status bar shown below.

4.

5.
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NXA83_User-Configuration_Password-length

1 User Configuration Screen: Status bar

To cancel the changes click the Cancel button. 

To exit the display without saving changes click the Exit button. This will return you to the 
previous display.

1
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11.3 Deleting an existing User Account
Log on with sufficient access rights. Select Admin → User Configuration from the main 
menu bar.

Select the account to be deleted by clicking the start of the row.
It is possible to delete multiple accounts. Select the rows to be deleted whilst holding 
down the CONTROL key. Each will be highlighted in turn.

NXA83_User-Configuration_Deleting-User

Click the Delete button, a message will be displayed indicating how many rows are to be 
deleted.

NXA83_User-Configuration_Confirm-Delete-Multiple

To confirm deletion click Yes otherwise click No.4.
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11.4 Editing an Existing User Account
Select Admin → User Configuration from the main menu bar.

Click the Edit button.

Navigate to the row and column to be edited and modify its contents.

NXA83_User-Configuration_Edit

Click the OK button to save the changes.

11.5 Forgetting Your Password
Your system administrator or anybody having administrative privileges can reset your 
password if you have forgotten your details.

4.
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12 Gauge Command Scheduler
The Gauge Command Scheduler is a Windows service that can be configured to send gauge 
commands at a specific time of day on a recurring basis.

The Gauge Commands can be sent to a Single Tank, all Tanks, or a group of tanks generally 
specified by Gauge Type. 

Care should be exercised when scheduling gauge commands, particularly those that affect a 
gauge’s primary measuring capability, as the tank may be involved in some sort of critical 
operation such as receiving product from a ship or similar. 

The Gauge Command Scheduler can be configured via the Tankvision Multi Scan 
Configurator tools.

12.1 Configuring Scheduled Commands
From the main page window, select the Tools → Command Scheduler Configuration menu 
item.
This will bring up the configuration application, which you can use tocreate, view and edit 
the scheduled commands.

NXA83_Gauge-Command-Service-Config

Command Schedule entries are listed on the left of the window, selecting one of these will 
display the details of the entry in the controls on the right.

Entry Details

Destination Denotes the way the gauges can be selected for scheduled item, either by a 
specific Tank ID, or collectively by Product or by Gauge Type.

Gauge Duty Where tanks are fitted with more than one gauge, this option is used to specify 
which gauge on the tank is to perform the command.

Command This is used to select the command to be executed by the gauge or gauges.
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When changes have been made to the schedule's detail, click Save to commit the changes to 
the database, or Cancel to discard them.
 
To create a schedule click New and edit the schedule as required. When the Save button is 
clicked this will add a new entry to the list on the left.
 
To change a schedule, select the schedule from the list on the left and click the Edit button. 
Changes saved now will overwrite the existing schedule.

To delete a schedule, select the schedule from the list on the left and click on the Delete 
button.

The Command Scheduler may be closed without saving changes by clicking the Exit button.

Custom Command If selected in the Command field this section is enabled to allow a custom 
command to be configured. Note that all the commands you can execute via the 
Multi Scan NXA83B are available from the Command list.

Schedule A scheduled command can be configured to send a single command once a day 
by ticking the Specified start box and entering a time into the field below. 
Commands can be sent at regular intervals by ticking the Command interval 
box and entering the interval period in the field below. 
It is also possible to execute a command between two specified times and a 
specified frequency by ticking the Specified start, Specified stop time and 
Command interval boxes. 
For example, to send a command every hour between the hours of 01:00 and 
04:00 you would set the start time as 01:00, the stop time 04:00 and the 
interval as 01:00.

Entry Details
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13 Gauge Commands and Remote Configuration
The Gauge Commands tool allows commands and configuration items to be sent directly to 
any gauges attached to the Multi Scan NXA83B and is included as part of the standard 
Tankvision Multi Scan Configurator.

To run the Gauge Commands tool requires that the database loaded into the Configurator is 
the current live runtime database, and that the gauges are connected and communicating 
with the Multi Scan NXA83B.

Gauges currently supported by the utility are:
• Endress+Hauser Proservo NMS5, NMS80 and NMS81
• Scientific Instruments 6290 Densitometer
• Enraf 854 servo gauges and 873 radar gauges
• Motherwell Gauges

Gauge commands can be gauge specific and therefore dependent on the gauge type.

For instance for Enraf gauges the following functions are supported:
• Dipping
• Displacement
• Test Gauge
• Alarm
• Maintenance
• Gauge Items

Other gauges may support other command and configuration functions.

The operations carried out in the Gauge Commands tools affect the operation or 
configuration of the gauges, they do NOT affect the Multi Scan NXA83B directly.

13.1 Launching Gauge Commands
From the Tankvision Multi Scan Configurator window, select Tools → Gauge Commands 
and remote Configuration.

NXA83_Gauge-Commanda-and-remote-Configuration
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NXA83_Gauge-Command

Where a tank has more than one gauge, the application will default to the primary gauge for 
the selected tank. Users can subsequently select an alternative gauge to operate on by 
clicking  next to the tank and selecting the gauge duty.

The appropriate set of options will be displayed for the gauge type.
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13.2 Sending a Command
Select the tank from the list in the left hand panel. Expand the tank with the  symbol 
(select the gauge in a multi-gauge setup).

The commands supported by the gauge will be enabled.

NXA83_Gauge-Command_Gauge-Items

Select the appropriate command from the list.

Set any required parameters and click the action button (dependent upon the command, 
Execute, Dip etc.).

Generally feedback and status of the command will be reported back to the user via the panel 
at the bottom of the window.
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NXA83_Gauge-Command_Gauge-Items_HA
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13.3 Enraf Gauge Commands
Enraf gauges support the following functions:
• Gauge Items is a general tool allowing the user to read or write any of the gauge items and 

view the returned data and or responses.
• Maintenance allows the user to set the reference level of the gauge.
• Dipping provides the various interface measurement modes such as Find Product 

Interface, Find Water Interface, and Density Dipping features.
• Lock Test allows the displacer position to be locked at a defined level.
• Verify Calibration checks the calibration accuracy of the gauge.

13.3.1 Gauge Items

NXA83_Gauge-Command_Gauge-Items_Feedback

This feature applies to Enraf and Motherwell gauges only.

The use of this feature requires a reasonable knowledge of gauging equipment and it is 
recommended that it is used by competent persons only.
This feature allows the user to read/write any of the gauge configuration items. To read an 
item, enter the item code and click on Execute, the response will be displayed at the bottom 
of the window. To write to an item, enter the item code, the data value to be written, and 
click on the Execute button.

Enraf Gauge Items

This feature supports the conversion units from those displayed in the Multi Scan NXA83B 
to units the gauge is configured to understand. In order to avoid confusion between the 
format used for settings made via a Portable Enraf Terminal (PET) and those of the Multi 
Scan NXA83B we recommend that you alter the units to match those used by the gauge.

To read a Gauge Item the Gauge Item Data field should be left blank. The data will be 
converted to the currently selected units before being displayed.
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When setting Gauge Items, the user must enter the data value in the exact format which is 
appropriate for the selected Dimensions/Units, with +/- sign and appropriate number of 
digits before and after the decimal point. If unsure of the correct format, read the current 
value of the desired Item from the gauge first. The response from the gauge will be displayed 
in the format appropriate to the Dimensions/Units in use. Use the same format to set the 
Gauge Item Data to the desired new value.

The following Dimensions/Units formats are supported:

Level

Temperature

Density

Pressure

All other Items use fixed formats that are unaffected by the Dimensions/Units selected by 
the user. Consult gauge manufacturer’s documentation for details.

Key Designation

± sign: character (+/–)

N numeric digit

. decimal point

Units Format

mm ± N N N N N N. N (default)

M ± N N N . N N N N

Ft ± N N N N . N N N

In ± N N N N N . N N

f-i-s ± N N ' N N " N N

Units Format

° C ± N N N . N N (default)

° F ± N N N . N N

Units Format

kg/l ± N N . N N N N N (default)

kg/m3 ± N N N N N . N N

lb/ft3 ± N N N . N N N N

° API ± N N N N . N N N

Units Format

Bar N N . N N N N N (default)

Pa ± N N N N N N . N

kPa ± N N N N . N N N

lb/in2 ± N N N . N N N N
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Motherwell Gauge Items

Motherwell gauge items do not have the same unit conversion facility applied to them. The 
data entered into the Gauge Item Data field is transmitted verbatim to the gauge. You should 
consult your Motherwell documentation to determine the precise format of the data.

With Motherwell gauges you can either specify a 2 digit hexadecimal item code, as described 
in the Motherwell gauge documentation or you can use a "shorthand" code for certain data 
items.

13.3.2 Maintenance

NXA83_Gauge-Command_Maintenance

If a gauge level reading differs from an operator's manual dip it is normal to re-align the 
gauge to the operator's dip.
This item is used to reset the reference level following a level dip.

The user must provide the new level dip and the level 2 password to access the gauge.
Select the tank (and gauge duty if necessary) requiring the new level dip.
Enter the Gauge password and New Gauge Dip level.
Click on the Dip button.

Shorthand Code Description

UR Upper Reference Level

RL Reference Level

HH High High Alarm Level

HA High Alarm Level

LA Low Alarm Level

LL Low Low Alarm Level
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This command uses the following sequence of Gauge Item instructions:

Enter the level 2 password using W2 gauge item.

Set the reference level using the RL gauge item.

Accept the reference level using the AR gauge item.

Exit and re-initialize the gauge using the EX gauge item.

The status of each item is displayed as it is processed.

When the EX command is issued the gauge will re-initialize. Gauge data may disappear for 
a short time during this process. After re-initialization the gauge level will read the new 
value.

13.3.3 Dipping

NXA83_Gauge-Command_Dipping

These generally apply to the Enraf 854 series of servo operated tank gauges.

Product Measurement Mode
This instruction sends the I1 Gauge Item and will cause the displacer to travel to the I1 
interface (Product level by default).
The gauge status is displayed throughout the process.
The gauge will remain at I1 until the user commands the gauge otherwise.

Density Dip – Tank Profile
Selecting this option will perform a 10 position density scan. This will start at the product 
level and end at the DZ Item position (0.30M by default).

Density Dip - Interface Profile
Selecting this option will perform a 10 position density scan over a reduced range, defined 
by the user. This is useful for density profiles around product interfaces e.g. Water interface.

4.
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Water Measurement Mode
This instruction sends the I3 Gauge Item and will cause the displacer to travel to the I3 
interface (Water level by default).
The gauge status is displayed throughout the process.
The gauge will remain at I3 until the user commands the gauge otherwise.

13.3.4 Lock Test

NXA83_Gauge-Command_Lock-Test

This command uses the MZ item to set the lock level, followed by the LT command to lock 
the displacer at the level specified by the user.

The user must provide the level at which the displacer will be locked and click on the Lock 
button.

If the Auto Unlock box is ticked, the lock will release after 10 seconds and the displacer will 
return to product level.

If the Auto Unlock box not is ticked, the displacer will remain in the locked position until 
commanded otherwise by the user.

Click on the Unlock button to unlock the displacer.
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13.3.5 Verify Calibration

NXA83_Gauge-Command_Verify-Calibration

This command performs a calibration test by using the CA item to move the displacer to the 
gauge Calibration Plate and comparing this level with the known Tank Top level. If the 
difference is greater than 2.5 mm, the verification fails.

The displacer will remain at the calibration plate until commanded otherwise by the 
operator.

The displacer start position is stored and displayed on the screen and the gauge status is 
reported at the bottom of the window.

To cancel calibration mode and return the displacer to Product Measurement Mode click on 
the Unlock button. 
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13.4 Scientific Instruments Gauge Commands
The 6290 densitometer gauge from Scientific Instruments supports a wide range of 
diagnostic and configuration parameters.

The parameters are grouped together into a number of pages, these being:
• System Settings
• Current Mode
• Current Status
• Current Data
• Profile Configuration
• Alarm Configuration
• Drive Configuration
• Sensor Configuration
• Sensor Calibration
• Host Configuration
• Host 1 Modbus Scaling
• Host 2 Modbus Scaling
• Diagnostics

The data displayed in a page is automatically retrieved from the gauge when it is opened. 
Therefore all data is considered live.

The meanings of the data parameters in the pages are not described in this document. For 
more information on these parameters, refer to the appropriate Scientific Instruments 
manual.

13.4.1 Page Selection
To display the parameters on any page, select that page from the list.

NXA83_Gauge-Command_Drice-Configuration

The parameters will initially be displayed with a value of ?? until the data is returned from 
the gauge.
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NXA83_Gauge-Command_Drive-Configuration_Values

13.4.2 Editing a Parameter
To edit a parameter on a page, double click on the parameter.

NXA83_Gauge-Command_Update-Item

Enter the new parameter in the dialog, and then click on Set.
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A confirmation screen will be displayed. Click Yes to write the data to the gauge.

NXA83_Gauge-Command_Confirm-Action

If the confirmation screen is not required, tick the Do not show this page again option. This 
will only last until the Gauge Commands utility is closed.

The parameter will be shown as Waiting for Answer until the new data has been written to 
the gauge and read back, after which the new value will be displayed in the page. 

Many of the parameters are read-only. These have a code that starts with the character "R". 
Any attempt to write to one of these will result in the following message being displayed.

NXA83_Gauge-Command_not-valid

(e.g. Instant Bottom Stop, item code R8)

13.4.3 Auto Refresh
To set a page to auto refresh the data at periodic interval, set the field Auto Update Screen 
Every to the interval period required, and then click on the Start button.

The data will now be refreshed at the rate specified. If the Auto Update period is set too low, 
the page will be continually refreshing, during which time the Waiting for Answer may be 
displayed. A refresh period of 10 seconds is the lowest value recommended, with 30 seconds 
as the more normal value.

13.4.4 Saving the data to file
The full set of data parameters may be updated and saved to an XML format file. This may 
then be printed or sent to SI for investigation if problems occur with the gauge.

The file will always be saved to the Logs sub-directory of the install directory.

To save the data, click on the page Save To File.
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NXA83_Gauge-Command_Save-to-File

Select the File Name in the Logs directory, and then click on the Execute button. All the data 
for all pages will now be automatically retrieved from the gauge. This may take some time, 
during which a progress bar will be displayed.

NXA83_Gauge-Command_Updating-Data

When complete, click OK. The data saved in the file will be formatted and displayed on the 
screen.
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NXA83_Gauge-Command_Save-to-File_Complete

Previously saved files may be viewed by selecting the File Name and clicking on the View 
button.
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13.5 Endress+Hauser Gauge Commands
Endress+Hauser V1 gauges support an Execute Gauge Command feature allowing the user 
to read or write to any Mode-Item specified in the product manual.

NXA83_Gauge-Command_Execute-Gauge-Command

The use of this feature requires a reasonable knowledge of gauging equipment and it is 
recommended that it is used by competent persons only.
This feature allows the user to read/write any of the gauge configuration items. To read an 
item, enter the mode-item code and click on Execute, the response will be displayed at the 
bottom of the window. To write to an item, enter the item code, the Gauge Command Data 
to be written, and click on the Execute button.

The response from the gauge will be in the format: 
• [command] [mode-item] [data]
• E.g. READ 0301 999999 – for reading mode-item 3-1

Ensure any command data being written conforms to the guidelines specified in the 
product manual.
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14 Technical Specification

Property Specification

CPU Intel Celeron N2807, 1.58 Ghz

Memory 4 GB

Disk 32 GB Disk On Module as C /D drive

Operating System Firmware 5.x.x: Windows 10 IoT

Firmware 4.x.x: Windows Embedded Standard 2009
Firmware 3.x.x: Windows XP Embedded

Display 7 in Widescreen module

Resolution 640 by 480

Keyboard Input 4–wire Touch screen connected to USB port

Standard Serial 4 COM ports

Expansion Serial 8 COM ports via PCI-104 daughter board
Up to 2 daughter boards may be installed

USB 4 ports, USB 2.0 Compliant
2 Internal / 2 External
1 Internal port is used for the touchscreen

Ethernet 2 ports, 10/100 MHz

Power Supply 110 to 240 Vac

Power Consumption 40 W

IP Rating IP20

Operating Temperature 0 to 40 °C (+32 to +104 °F)

Storage Temperature 0 to 85 °C (+32 to +185 °F)

External Dimensions Rack Mount: 482.6 mm × 178 mm × 315 mm (19 in × 7.01 in × 12.4 in)

Mounting To suit M6 bolts, four positions

Weight 2 kg (4.41 lbs)

Approvals CE
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15 Troubleshooting
The following are some fail modes that may occur during commissioning:

Gauge(s) are displayed with all data DN00 and the "No reply from gauge" alarm is set.
• Check that the data loop is connected to the correct port on the Multi Scan NXA83B and 

that the wiring is correct.
• Check that the COM port has been configured with the correct protocol and 

communication parameters (baud rate, parity etc.).
• Check the gauge configuration for the correct gauge addresses and other gauge specific 

communication parameters.

The Tankvision Multi Scan continually reboots on startup.
• Disable the Multi Scan NXA83B Watchdog (see section Multi Scan NXA83B Watchdog) to 

prevent the system rebooting automatically.
• Check the database configuration for faults and re-download the database using the 

Tankvision Multi Scan configuration tools, then reboot.
• Re-enable the watchdog and reboot. If the symptoms persist, disable the watchdog and 

contact Endress+Hauser for support to investigate the reason key system services are 
failing.
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